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Om dig

Denne e-bog er skrevet til dig, som enten har gennemfort et indledende statistikkursus eller
er i gang med det. Bogens case er boligmarkedet, fordi det er et emne, alle kan forholde sig
til — uanset om du er studerende eller skal til at bruge SAS i dit job — og uanset om du er polit.,
farmaceut, mediciner, biolog, matematiker, erhvervsekonom eller aktuar. Fellesnevneren er
kendskabet til indledende statistik og en ambition om at leere SAS pé en formiddag.

Om forfatteren

Denne e-bog er skrevet af Morten Fenger, cand.merc.(scm.) fra Aarhus Universitet (AU).
Morten kender SAS som forst studerende og siden underviser i AU’s IKT-afdeling. Morten
har veret instruktor i fagene Statistik I og I, Videnskabsteoretisk Metode II, Okonometri,
Statistisk Simulering og Data Mining. Morten arbejder i dag som research assistant pa AU,
hvor han anvender SAS til handtering og analytics af ”big data”.

Om komitéen bag denne e-bog

SAS tager dig som leser alvorligt, og SAS’ uddannelsesansvarlige Georg Morsing har derfor
sammen med SAS’ analyseekspert ph.d. Kaare Brandt Petersen sat kursen for denne e-bogs
faglige indhold og approach. SAS Academics’ projektleder Ane Gerken har under hele
processen sorget for, at denne e-bog har fokus pa at fa dig let og hurtigt i gang med SAS.

Denne bog tager udgangspunkt i Gorm Gabrielsens introduktion til JMP* og introducerer
SAS med den samme gennemgaende case.

Har du kommentarer eller spergsmal til denne e-bog eller andet inden for SAS, kan du altid
skrive til academic.dk@sas.com, hvor vi kan hjzlpe dig videre med SAS.

* JMP er et andet statistikprogram fra SAS med fokus pa at skabe overblik over data
for store analyser i fx SAS.
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EN KORT INTRODUKTION

TIL SAS OG DENNE E-BOG

Velkommen til denne e-bog, som er skrevet til dig, der gerne vil hurtigt i gang med at
anvende SAS. Bogen er inddelt i 4 kapitler, som igen er inddelt i afsnit og underafsnit, jf.
indholdsfortegnelsen pé side 3. Her 1 kapitel 1 introduceres SAS og bogens gennemgéende
case og dataseat. I kapitel 2 importerer vi et datasat fra Excel til SAS og laver et par @ndringer
1 datas@ttet — SAS anvendes nemlig ofte til datahéndtering. 1 kapitel 3 udferes diverse
statistiske analyser i SAS. Fokus er pa at introducere teknikkerne og at komme omkring de
mest anvendte statistiske metoder i praksis. Hvis du gerne vil ga direkte til kapitel 3, kan
du finde e-bogens analysedataset pd www.sasacademic.dk under fanen “Til undervisning”
eller pA www.sasdownload.dk Kapitel 4 giver en let introduktion til SAS-programmering og
opsummerer denne e-bog pa et par siders SAS-kode.

1.1. Hvad er SAS, og hvorfor er programmet sa stort?

SAS er blandt verdens mest komplette statistik- og datahandteringsprogrammer. SAS kan stort
set alt inden for statistik og datahandtering. Mange af verdens storste virksomheder anvender
SAS, og stort set alle danske C20-virksomheder er blandt SAS’ kunder. Virksomheden bag
SAS hedder SAS Institute og har hovedkontor i North Carolina i USA.

SAS er et stort, avanceret datahandterings- og analysesystem, som startede med at blive
udviklet allerede i 60’erne pa North Carolina State University. Oprindeligt var det et
forskningsprojekt til at analysere landbrugsdata, men projektet voksede hurtigt til andre
forskningsfelter. Og heldigvis er der sammenfald mellem, hvad man lerer pd universiteterne,
og hvad virksomheder beskaftiger sig med, s& SAS blev til en selvstendig virksomhed i 1976
og har siden da leveret dataanalytiske verktejer til verdens sterste virksomheder inden for
alle tenkelige omrader som medicinalindustrien, banker, forsikringsselskaber, teleselskaber,
universiteter og offentlige forvaltninger — i hele verden.

Som alle andre computerprogrammer med mere end 20 ars historie har SAS udviklet sig fra
et kodebaseret sprog til et moderne peg og klik- system. Alle funktioner er bevaret, og flere
nye er kommet til. Det betyder, at du nu kan vere i gang med at anvende SAS i prak51s paen
formiddag og to kopper kaffe. SAS-kodning lyder sverere, end det er — vi introducerer det i
kapitel 4 og viser, hvordan det kan bruges som en alternativ made at lose de samme opgaver,
som vi vil gennemga i peg og klik-SAS i kapitel 2 og 3.

De SAS-koder, der blev skrevet i SAS i 1968, er konvertible med de nyeste versioner af
SAS. Der er bare blevet bygget oven pa SAS-systemet lige siden, og der kommer stadig nye
funktioner til, i takt med at forskningen udvikler det statistiske felt. Derfor fylder programmet
lidt, og det tager lidt tid at installere. Til gengeld betyder det ogsa, at de koder, du skriver i
SAS i dag, med garanti ogsa kan kere i fremtidige versioner af SAS.

Hvis du ikke allerede har installeret SAS, kan du finde en installationsvejledning pa
www.sasacademic.dk under fanen ”Support”.

1.2. SAS pa Windows og Mac

SAS er bygget til at kere 1 Windows, fordi det er det, de fleste virksomheder anvender. For
brugere, der foretraekker Mac, betyder det, at man forst skal installere Windows-styresystemet
pa sin Mac. Man kan bruge softwaren WMware Fusion eller Boot Camp til dette. Nar forst
dette er gjort, mangler man bare at installere SAS.

Det kan altsa sagtens lade sig gore at kere SAS pa en Mac — alt i forhold til denne e-bog er
faktisk udarbejdet pa en Mac.
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1.3. Introduktion til datasaettet anvendt i denne e-bog

Denne e-bog tager udgangspunkt i noget, vi alle kan forholde os til, nemlig boligmarkedet.
Uanset om man er mediciner, farmaceut eller gkonom, sa kan vi nok alle sette os ind 1, at der
er sammenhange mellem prisen pa en bolig og fx sterrelsen, antal varelser, herlighedsverdi
etc.

I en sondagsavis engang i ar 2000 var der en masse boliger til salg, og 69 af disse var huse nord
og syd for Kebenhavn. Lad os for sjov skyld antage, at det er noget data, du har indsamlet og
registreret, fordi du er pa jagt efter en ny bolig i Kebenhavnsomradet. Informationen om disse
huse har du samlet i en stor tabel, hvor hver reekke har med én boligannonce at gore. Hver
kolonne kaldes en variabel, og et eksempel er, at hver boligannonce har en kontantpris. Sidan
en tabel kaldes et datasat i statistiksprog.

I de folgende analyser antager vi, at stikpreven af boliger er reprasentativ for alle huse nord
og syd for Kebenhavn, dvs. vi antager, at det er et tilfeeldigt udpluk af disse boliger, der er til
salg pa denne givne sendag i ar 2000.

De forskellige variable i datas®ttet er:

nr Nummeret pa annoncen (tilfeeldig rekkefolge)

geografi Kommunen, hvor huset ligger

kontantp Kontantpris i 1.000 kr. (fx betyder 995 at huset koster 995.000 kr.)

boligst Boligsterrelse i m?

grundst Grundsterrelse i m?

vaerelse Antal verelser i huset

omr Omrédevariablen angiver, om huset ligger nord (omr = 1) eller syd (omr = 2)
for Kebenhavn

kvalitet Udtryk for herlighedsvardien af huset vurderet mellem 1 (lav) og 5 (hej)

kvalitetgr Gruppering af kvalitet 1 niveauerne: 1 (lav, dvs. kvalitet = 1 eller 2), 2 (mellem,

dvs. kvalitet = 3) eller 3 (hej, dvs. kvalitet = 4 eller 5)

@ nr !@ geografi @ @ boligst @ grundst @ vaerelse L@ omr @ kvalitet @ kvalitetgr [
1 1 Brondby 935 150 695 22 1 1
B 2 BrondbyStrand 1478 105 <) 32 3 2
By 3 Espergarde 3100 278 1815 61 2 1
4 | 4 Espergasrde i 2250 .20 B 885 401 3 2
5 | 5 Espergaerde ) 1885 B 130 627 31 3 2
3 6 Espergaerde 1895 169 702 301 3 2
7 7 Espergmrde 2% 167 634 31 4 3
8 | 8 Espergmrde | 2100 133 est 21 3l 2
9 | 9 Espergasrde 2700 255 1120 51 3 2
10 | 10 Greve 3995 m 3221 4.2 4 3
m | 11, Greve 4200 179 736 62 5 3
12 12 Greve 1595 146 756 32 2 1
13| 13 Greve [ 1450 T ) 766 32 1 1
14 | 14 Greve 1295 81 850 22 2 1
15 | 15 Greve 1895 165 788 312 3 2
16 16 Greve 1495 135 810 32 2 1
Bl b e 11 15 -2 ;
18 | 18 Greve 3100 193 788 42 5 3
a8 18 Greve s o ) 758 32 3 2
20 20 Greve 1365 124 732 32 2 1
Fi 21 Greve 1975 185 m 42 2 1
2| 22 Horsholm 1669 121 384 31 3 2
23| 23 Hersholm 1795 121 812 31 3 2
24 24 Hersholm 24% 160 2285 31 1 1
25| 25 Hersholm [ - | s 51 4 3
26 | 26 Hersholm 2% 154 799 41 3 2
27 27 Hersholm 1897 122 462 31 3 2
- 3 e ; e e — e R 3 :
2| 29 Hersholm TTTTTag AT T e 31 g 2
30 | 20 Hersholm 2438 177 747 41 4 3
31 31 Humlebzek 1745 143 805 41 2 1
32 32 Humlebaek 4700 2% 1700 4 5 3
33 33 Humlebaek 2400 158 1204 81 3 1
34| 4 Humlebzek 2625 181 525 41 4 3
35 | 35 Humlebzek 1850 151 1018 41 2 1
36 36 Humlebaek 1950 138 713 31 3 2
A 37 Humlebaek CTTTHRRYL e 61 4 3
38| 28 Ishej 1275 115 482 32 2 1
39| 39 Ishoj 1585 181 656 62 1 1
40| 40 Kokkedal T e Bk T 31 3] 2
a1 A1 All~dal 1408 1"M7 704 21 2 1
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1.4. Hvordan er SAS bygget op?

Nedenfor ser du SAS-brugergrensefladen, som den fx kan se ud. Overst er dropdown-
menuerne, hvor alle funktioner findes. I everste venstre hjorne er Project Tree, hvor man i
en hierarkisk struktur kan holde overblik over sit SAS-projekt. I det store felt everst til hgjre
ses Process Flow-diagrammet. I Process Flow far man et godt overblik over sit projekt. Man
kan se, hvad man har gjort med sine data og i hvilken rekkefolge. Det er virkelig smart til
at bevare overblik og navigere rundt i projektet. I Excel har du mange forskellige regneark.
I SPSS har du kun ét dataset ad gangen og sa en uoverskuelig rekke af outputs. I SAS har
du det forkromede overblik via Process Flow, som automatisk genereres, nar du arbejder 1
SAS. Som du maske kan gaette ud fra Process Flow-diagrammet nedenfor, har jeg importeret
et Excel-datasat i SAS. Hvis nu der kommer en @ndring i Excel-filen, kan man automatisk
importere et nyt, opdateret datasaet i SAS med et enkelt klik. Og hvis vi nu var pa sidste side
i denne e-bog og allerede havde lavet en masse analyser baseret pa dette datasat, sa kunne de
automatisk blive opdateret baseret pa det nye dataset med ét klik pd Run-knappen i vores
Process Flow-diagram. Det er altsa ret smart, serligt i store projekter.

& SAS Enterprise Guide - Boligdata projekt.egp

Fle Edt View Tasks Program  Took Hep v (G- @ & o Dn (1 X 9 o | S SegProcess Flow ~
| Project Tree + x ProcessFhw - = x
3 g‘?‘& Process Flow P Run + Schedule ~ | Zoom ~ | [ Project Log Properties ~
= %) Boligdataxlsx A
@ Import Data (Boligdata dsx{Bohgd:
Xl-—— -
>
Boligdata.. Import Data
Data (Bol... Impocted ..

v
< >1€ >
Server List . x Import Data (Boligdata. xlsx[Boligdata.xls]) ~ x
mHAaAe 3 ] Code | [Z] Log| &4 Output Data -

€5 [5] Modify Task | &3 Filter and Sort &5 Query Buider | Data v Describe v Graph !
) i
2 7/ - & & A
@ 8 Sewers @ nr M\) geografi @ kontartp }@ boligst }@ grundst
+ [y Privale OLAP Servers o 11Brendoy 995 150 6
2 2 BrendbyStrand 1478 105 6
B | 3 Espergaerde 3100 278 18
4 | 4 Espergzerde 2250 203 8
5 | 5 Espergaerde 1885 130 [
6 | 6 Espergzrde 1895 169 7
7| 7 Espergeerde 2595 167 6
8 | 8 Espergzerde 2100 133 9
< >
Ready & No profile selected

Nederst til venstre i skeermbilledet er der en oversigt over servere. Det er noget, man bruger,
hvis man anvender SAS i store organisationer med data pa diverse fellesdrev og servere med
gigantisk beregningskraft. Man kan sagtens lukke den boks ved at klikke pé det lille gra kryds
til hejre for Server List (den kan altid findes frem igen via dropdown-menuen View.)

SAS er et dynamisk program, og serligt feltet til hejre vil skifte indhold, athengigt af hvad
man er i gang med. Hojre halvdel af skaermen bestar typisk kun af et stort felt med det,
man har fokus pa, men her har jeg delt min skaerm 1 to for at kunne vise bade Process Flow-
diagrammet og et datasat samtidig (det er gjort via View > Workspace > Layout, hvis du
absolut vil vide det, men det er ligegyldigt her).

I det store felt nederst til hojre ses et eksempel pa, hvordan et dataset ser ud i SAS. Lag
merke til fanebladene i feltet nederst til hojre. Klikker man p& dem, @ndrer feltet indhold. Du
kan velge at se koden, som kerer inde bag ved i SAS-maskineriet. Du kan ogsa se en log fra
sidste korte analyse/datahdndtering. Ingen af delene behover du dog at forholde dig til i denne
e-bog — vi snuser blot til det i kapitel 4.

Stort set alt i denne e-bog kan laves fra dropdown-menuen Tuasks, hvor bade diverse
datahéndtering, grafer og statistiske analyser kan laves. Du finder ogsa mange af de samme
valgmuligheder i "bjelken” over dataseattet i skermbilledet, og det er ofte via den bjelke, vi
vil kere analyserne i denne guide. Lige om lidt skal vi preve at importere det dataszt, vi skal

arbejde med fra Excel, ligesom det er gjort i billedet ovenfor.
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GOR DIT DATASAT KLAR

TIL ANALYSER | SAS

For vi kan gé i gang, skal du selvfolgeligt have SAS installeret. Du kan finde installationsfiler
og vejledning til installationen pa www.sasacademic.dk. Denne e-bog antager i det folgende,
at du allerede har SAS installeret.

2.1. Abn SAS og importer dine data fra hvilken som helst kilde

SAS startes som alle andre programmer via Start > Programmer, og derefter vaelges SAS >
SAS Enterprise Guide som nedenfor:

fﬁl J_ﬁ CutePDF 3 l@ additional Languages 4
Ul . 5
PACToisof Mok 201 @ Internet Explorer ) uilities 3

@) Microsoft Office » | & sas 9.3 (English)

fe Internet Explorer
L

‘ Microsoft Security Essentials . SAS Deployment Manager
B8 Adobe Reader ¥
@ Samsung

allPrograms | B sas @@ sAS Locale Setup Manager 3.1

ﬁ] Log OFf @ | Turn OFf Computer

S
f& 5AS Enterprise Gu

SAS GRAPH QDS Graphics Editor 9.3

Nar SAS é&bnes, kommer velkomstskermen frem. Der vil man kunne valge sit projekt, neste
gang man abner SAS, men forste gang man abner SAS, er listen over tidligere SAS-projekter
selvfolgelig tom.

Vi klikker pa New Project cirka midt pa velkomstskermen nedenfor:

& Welcome to SAS Enterprise Guide @

Select one of these options to get started:
Open a project A
& C:\Documents and Settings\Admiristrator\Desktop\SAS Projects\CPUANalysisSurfacePlol e
& C:\Documents and Settings\ddministrator\Desktop\SAS Projects\CPUANalysiséreaPlot egp
& C:\Documents and Settings\Administrator\Desktop\SAS Projects\CrimeStatislicsM apping.eqp
& C:\Documents and Setings\Administrator\Desktop\SAS Projects\Project predicting NOVO B.e
& C:\Documents and Settings\Administrator\Desktop\SAS Projects\HBAT project.egp
E; More projects ...
New
@ New Project
*J New SAS Program
l:: New Data
Assistance
L. Tutonial: Getting Started wih SAS Enterorise Guide

[ €

[T]Don't show this window again
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Sa er vi klar med et nyt, tomt projekt!:

[& SAS Enterprise Guide E@@

File  Edit “iew Tasks Program Tools  Help %- [év Eﬁ Hy [Z A i gqurocess Flaw =
Project Tree + x ProcessFlow -
g?g Z0am - T}ProjectLog Properties hd
~
Server Lisk - X
& HA®eH
>
- F Servers
+ ]% Private OLAP Ser
w
£ >
< >
Ready \Q Mo profile selected

For vi gér videre, vil vi lige foretage en enkelt indstilling, som gor vores SAS-/ogs lettere at
lese. Vi anvender egentlig ikke SAS-/ogs i hovedparten af denne e-bog for enkelhedens skyld,
men bare lav indstillingen nedenfor alligevel — du kommer maske til at se pa logs senere —
maske bliver du bidt af SAS.

Velg Tools > Options, velg derefter Results General og fjern det nederste flueben 1 billedet
nedenfor under valgmuligheden Show generated wrapper code in SAS log:

File Edt ‘iew Tasks Program | Tools | Help =] B 5 [En Optiens
i - Add-In 3
IFEEEE THE2 R Frocesshlow Genersl Results > Results General
g?g ij Create HTML Document. .. Proisct Views
il Project Recovery
ci) Style Manager... Results Result Formats
L i era [7] 545 Feport [THTML [JPDF
& SA5 Enterprise Guide Explorer... Wi
545 Report CIrTF [ Text output
@ Assign Project Library... HTML
Default:
¥ RTF
PDF Managing Resuls
Graph
Project Maintenance Stored Process Replace resuits: Prompt before replacing v
Data
Data General Display SAS log when erors ocour
Peiformance Automaticaly opsn data o results when generatsd
| © optiors. . Query [] &utomatically add output data to the project tree
HLAP Data [7] Link handcoded DS resull
Tasks ink handcade tesults
Tasks General Change task icon when wamings occur
Custom Code ] Shaw generated wiapper code in 545 log
Output Library

Det var det — nu er vores log lettere at lese, hvis vi skulle fa brug for det.
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2.1.1. Fortzl SAS, hvor dine data ligger: SAS libraries

Det forste, vi gor 1 SAS, er at fortelle SAS, hvor vores data fra vores projekt skal legges. SAS
kan kere pa alt fra en almindelig computer til store, komplekse serverlgsninger, sa derfor er det
ikke givet for SAS, at dine data ligger pa dit C-drev eller dit skrivebord. SAS har derfor sit eget
system til at holde styr pa data, nemlig databiblioteker eller /ibraries, som det kaldes i SAS. Et
SAS library er faktisk bare en forkortelse for en sti til dataene. Vi vil lave et library, som vi vil
kalde BOLIGLIB. Det gores ved at veelge Tools > Assign Project Library... som vist nedenfor:

& SAS Enterprise Guide
File  Edit  Wiew Tasks  Program | Tools | Help E‘]*ﬁ* % =

Project Tree + % Process Flow = Add-In »

gQg Process Flow Create HTML Docurment. ..

b N

Skyle Manager. ..

[fh,  5AS Enterprise Guide Explorer...
|E Assign Project Library, ..

Herefter skal man navngive sit /ibrary. Vi kalder det BOLIGLIB og trykker derefter Next:

& Assign Project Library E
1 of4 Specify a name and server for the library. Ssas

This wizard assigns a library for the curent project and the current user. This library will be un-assigned when you exit the
application. |f you want to create a permanent ibrary on a server, create a server library definition by gaoing to menu T oolz-»
Enterprize Guide Explarer.

MHame [enter 8 or fewer characters):
BOLIGLIB

Serven

Local - The SAS zerver on your machine v

I et Cancel Help
I
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P4 naste skermbillede nedenfor skal vi angive, hvor vi gerne vil gemme vores SAS-data. Her
er valgt en mappe, som jeg har kaldt SAS Projects, som ligger pa mit skrivebord i Windows.
Man velger et sted ved at trykke pd Browse, og man navigerer dernast frem til det onskede
sted. Tryk derefter pa Next:

2 aof4 Specify the engine for the librany. SSaS

Enagine type:

File System w

Additional information needed for File Spstem’

[] Let 545 chonse the engine based on the contents of the specified path.

E ngine:

BASE - Latest version of Base SAS v
Path:

CADocuments and Settings\AdministratoriDeskiophSAS Projects

Tryk pa Next igen og tryk derefter pa Test Library. Hvis du har valgt en placering, du har
skriverettigheder til, s& vil SAS fortelle dig, at dit /ibrary er gyldigt (der star bare OK’).
Tryk nu pa Finish, hvorefter der kommer en /og frem som nedenfor. Loggen er i princippet
ligegyldig, men hvis du vil, kan du skimme den igennem. Kig efter den grenne tekst, som
er det vigtige. Og skulle der vare rod skrift, kan du regne ud, at det betyder, at der er noget
galt med koden, og loggen fortaller dig sa, hvad der er galt (det kunne fx vere, at du provede
at dbne et dataset, som du i mellemtiden havde flyttet). I vores log nedenfor er alt dog i sin
skenneste orden, og det vil det ogsa vere i resten af denne e-bog:

Assign Project Library (BOLIGLIE) - x
fl Code| =] Log
mModiFy Task | Export » SendTo - ¥ Eproject Log Properties
MNOTE: Libref BOLIGLIE was successfully assigned as follows: ?
Engine: BASE

Fhysical Name: C:i%Documents and SettingshAdministratorsDesktoph3A8 Projects

P4 fanen Code kan du se den kode, som SAS genererer. Bare se helt bort fra fanerne Code
og Log indtil videre. Vi snuser lidt til SAS-programmering i kapitel 4, men du behover
ikke vide noget som helst om det for at komme godt i gang med SAS i denne e-bog
Skynd dig derfor at trykke pa Process Flow-knappen pa skaermen (BegProcess Flow ), og du vil
kunne se, at vores SAS library er blevet oprettet:

f& SAS Enterprise Guide

File Edit ‘¥iew Tasks Program  Tools  Help | (5~ - 98 = - gquru:u:ess Flow -
Project Tree - ¥ Process Flow
g Process Flow [ Run - Export = Schedule = Zoom - f}Project Log Properties =

E Agzign Project Library |

p.i

Agzign
Project L.

Vier nu klar til at ga videre...
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2.1.2 Importér data fra Excel

De fleste softwaremanualer starter med at give dig et datasat i programmets eget dataformat.
Sadan et dataset kan du ogsé finde pd www.sasacademic.dk klar til brug. Men eftersom du
nu leser denne SAS-intro-e-bog, er det nok, fordi du ikke har arbejdet s& meget med SAS for.
I Excel er du sikkert mere pa hjemmebane, s& derfor vil vi starte med at importere et Excel-
regneark til SAS. Sa kan du selv se, hvor let det er.

Vi veelger File > Import Data som nedenfor:

[ SAS Enterprise Guide

File | Edit Wiew Tasks Program  Tools

= Mew >

E"— Open 3
Close Project

&y sSave Project Chrls

Save Project As...

|

|ﬂ‘_‘!' Impart Daka |

Derefter finder vi frem til vores Excel-fil Boligdata.xlsx, som her ligger pa skrivebordet.
Markér filen og tryk Open:

Lockin: |75 Desktop .
@ Deskiop |} My Documents
_f My Computer

() by Documents % J My Nebwork Places
. & WMware Shared Folders
'« My Computer |- 5A5 Projects

) My Network S Boligdata, xlsx

Herefter fremkommer dialogboksen nedenfor. Laeg merke til, at SAS allerede er i fuld gang
med at illustrere dine handlinger i Process Flow-diagrammet ude til hojre nedenfor. Lad os
importere Excel-datasattet til vores /ibrary. Det gores ved at trykke Browse i1 dialogboksen, og
derefter veelge Save in: Libraries overst til venstre...

Process Flow -

P Run = Export ~ Sch[eduh: » | Zonm +  [Zd Proiect Lon | 5] Pronerties
wi o) |®i save File
1 of4  Specify Data Ssas Save in: WwWORK 3
Assign 1! =

Project L

The Impart Data wizard is used to convert non-SAS data into a SAS data file which is required by other tasks for B Servers

data analysis and reporting

Bdligdata... Source data file

Data Bol

Locatian: Local File Spstern
File path C:A\Documents and SettingsiadministratorD esktop\Boligdata. xlsx
Data type: Excelwoarkbook v

Output SAS data set

SAS server Laocal Browsse.
Library: WORE
Data set: Boligdats

... hvorefter vores library BOLIGLIB velges...
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i Save File
Save in: Libraries | -

[ Servers Nare Descriptic
SASHELP
SASUSER
WORK

... og der trykkes OK > Save. Nu fremgér det af vores dialogboks, hvor det importerede data
bliver gemt:

COutput SAS data zet

SAS server Local
Library: BOLIGLIE
[ata set: B oligdata

Tryk Next. P& naste trin foreslar SAS selv at importere fra dataarket Boligdata, og at forste
rekke 1 Excel-regnearket indeholder variabelnavnene. Begge dele er fint, sa vi laver ikke nogen
@ndringer her:

2 ofd  Select Data Source ssas

Select range

(2} Use a worksheet First raw of range containg field names

| Fiename columns to comply with SA5 naming
cohventions.

Tryk Next igen, og vi kan nu angive, om vores variable skal opfattes som tal i SAS (number)
eller ikke som tal (string). Variablen Geografi er den eneste, som SAS ikke leser som et
nummer. Variablen omr er godt nok ogsa et tal, men der kunne lige sd godt have staet Nord/
Syd 1 stedet for I eller 2 i denne variabel (husk, at det er sddan, denne variabel er defineret — se
evt. variabeloversigten pa side 5). Derfor valger vi at fa& SAS til at importere omir-variablen
som String-type. Det gores ved at velge Type: String og derefter klikke OK til pop op-boksen,
om SAS selv skal finde et passende format (pop op-boksen er ikke vist her):

3 of4  Define Field Attibutes S)S&S

Select columng and define attibutes:

e Mg MNeme  Lobel TP o L Fomat  Inomet
rir rir Mumber | BESTI12, g BEST12. BEST1Z
geografi geografi Skring FCHARTS. 13 | $CHAR1I3. | $CHARTS.
kontantp kontantp Mumber  BEST12 a BEST1Z. BEST12.
boligst boligst Mumnber | BEST12. g8 BEST12. BEST12.
arundst arundst Mumber | BEST1Z a BEST1Z BEST12.
waerelse waerelse Mumber | BEST1Z2 a BEST1Z. BEST12.
SCHART. SCHART. | $CHART.
kewalitet kewalitet Mumber | BEST12 8 BEST12. BEST1Z
kwalitetar kvalitetar Mumber | BEST12 a BEST1Z. BEST12.
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Vi kan nu trykke Finish, hvorefter datasattet nedenfor fremkommer (kun de forste rekker er
vist):

Impart Data (Boligdata.«lsx[Baligdata.«s]) -

=] Code| 2] Lag 4 Output Dats
CS mmndwfy Task ﬁFilter and Sort ﬂjQuery Builder | Data = Describe » Graph = Analyze » | Export = Send To -

@ nr |.{‘) geografi @ kontanip I@ boligst @ grundst @ vaerelse |.(‘) omi @ kwalitet @ kvalitetgr
355

1 1 Brandby 150 B35 2:2 1 1
2 2 BrondbySirand 1478 105 B30 3z 3 2
3 3 Espergeerde ea i) 278 1815 61 2 1
4 4 Espergaerde 2250 203 885 41 3 2
5 5 Espergzerde 1885 130 B2 31 3 2
6 E Eszpergzerde 1895 169 o2 31 3 2
Fi 7 Espergaerde 2595 167 ES4 31 4 3
] R Fenemaerde nn 133 aR1 1 ki ?

I Process Flow-diagrammet kan man tilsvarende se det importerede dataset:

Process Flow =

= Fun - Expott = Schedule = | Zoom -
Azziagn
Froject L...
X]——e
a
Boligdata... Impart Data
Data [Bol... Imported ...

Sé let var det. Velkommen til SAS.

OBS: For du lukker SAS ned, sd husk at gemme dit projekt. Ndar du skal arbejde med det igen,
henter du projektet ind og korer det ved at trykke pa 'Run’ og derneest ’Run Process Flow’ via
knappen overst til venstre i 'Process Flow’-diagrammet. Det er vist nedenfor:

Process Flow -

[ Run = Export = Sch

| Fun Process Flow |

Run Project

Pd den made bliver alle dine indtastninger og analyser opdateret. I SAS-projektfilen ligger nemlig
koden til alle handlinger foretaget i projektet. Smart ikke?

Ggsas
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2.2. Fa overblik over dit datasaet

For man gar i gang med at analysere data, er man nedt til at have overblik over sit dataszt.
Det kan man fa ved at beregne opsummerende tal for datasattets variable, fx gennemsnit
af variable (underafsnit 2.2.2) samt ved at lave diverse grafer ud fra datasattets variable
(underafsnit 2.2.3). For vi gér i gang med den beskrivende statistik, kommer der dog lige en
kort intro af datatyperne i SAS og i statistik generelt (underafsnit 2.2.1).

2.2.1 Datatyper i SAS

SAS arbeider grundleggende med to datatyper: tal eller tekst. Symbolerne er hhv. @ for
tal og ,{:ﬂ. for tekst. Tekstvariable er typisk ord, fx kommune, men det kan ogsa vere tal, x
postnumre. Grunden til, at det kan veere en god idé at klassificere nogle tal som tekst, er, at det
fx ikke giver mening at beregne et gennemsnit af postnumre.

I statistik arbejder man ofte med tre datatyper: intervaldata (ting, der kan maéles og vejes),
ordinaldata (tal, der kan sattes i rekkefolge, men hvor afstanden mellem hvert trin ikke
nedvendigvis er den samme), og nominel data (kategorier). Grunden til, at SAS kun har
to datatyper, er, at det giver nogle friheder i forhold til datahdndteringen. Men det betyder
sa samtidig, at man selv skal holde tungen lige i munden i forhold til, hvilke variable man
anvender som hhv. interval- eller ordinaldata i de analyser, man laver.

Datatype i SAS Datatype i statistisk teori

Intervaldata (man kan beregne gennemsnit, fx gennemsnitlig lebstid i et
3 motionsleb)
pk|

Number @

Ordinaldata (man kan kun rangordne, fx placering i et motionsleb)

Y Numerisk data (man kan kun regne andele ud, fx andelen af lobere, der
String “=* gennemforte motionslobet pa under 1 time)

2.2.2. Beskrivende statistik
Nar man far et nyt dataset foran sig, er det altid godt at starte med at danne sig et overblik
over det. Det gores typisk ved at opsummere vores datasat i nogle enkelte tal, som giver os

overblik over hele datasattet og dets variable.

I SAS vil vi ferst abne vores datasat ved at dobbeltklikke pa SAS-datasattet i Process Flow-
diagrammet:

Data
Imported ..
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Herefter trykker vi pa Describe 1 baren over datasettet, og vi velger Summary Statistics, som
kan beregne grundleggende, beskrivende statistiske mal sdisom gennemsnit, standardafvigelse,
minimum- og maksimumvardier samt stikprovesterrelsen:

[ata Imported From Boligdata, zlsx -

ﬁFilter and Saork %Querv Builder = Data - |Cescribe «| Graph ~ Analvze = | Export =
) nr . geografi l@ Lisk Data. .. |
1 14 Erandby = e U
2 > BrandhyShand = ummary Statistics Wizard, .,
2 3 Espergaerde | % Summary Stakiskics... |
;— ; EEEZE:E: [E]  summary Tables wizard. .,
B 6 Espergeerde [l summary Tables. ..
| 7 Espergeerde [ Lisk Report Wizard. ..
8 8 Ezpergeerde _
q 9 Espergzerde ["j Characterize Data. ..
10 10 Greve |y Distribution Analysis, ..
L 11 Greve One-Way Frequencies, ..
12 12 Greve . -
13 13 Grave £ Table and 3.-'5|s...
Nar Summary Statistics velges, skal det angives, for hvilke variable man ensker at fa

opsummeringer. | forste omgang velger vi alle intervalvariable, dvs. kontantpris, boligst,
grundst og vaerelse:!

Summary 5Statistics for Local:WORK.BOLIGDATA

[ata

Statiztics
Bazic
Percentiles
Additional

Plots

Results

Titles

Properties

Data

Yariables to assign: T azk rales: L
M arne i Analysis variables

123 nr @ O antp

e . @

A geografi -

@ kaontantp % =

. | i

@bullgst = il .

@ dat 45 Classification variables
2 grunds

| Frequency count [Lirmit

@ vaerelse i Relative weight [Limit:

< amr _ 45 Copy variables

@ kevalitet 45 Group analysiz by v
< >
The wariables that vou azsign to this role are the numeric varables on which you want to
have statiztice generated. vou must azsign at least one vanable to this rale.

=] Preview code

Run V] [ Save ] [ Cancel ] [ Help

1. Variablene kvalitet og kvalitetgr er begge ordinale, da afstanden mellem en rating pa 1 og
2 ikke nedvendigvis er den samme som afstanden mellem 4 og 5, da det jo er en subjektiv

vurdering.
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Under Basics kan vi specificere, hvilke beskrivende statistikker vi gerne vil have med pa vores
output (fx Mean, Standard deviation etc.), samt antal decimaler vi gerne vil have pé vores tal.
Velg 2 decimaler. Resten behover du ikke @ndre pa:

Dat'f:' . Statistics > Basic
Statiztics
B azic
Fercentiles Baszic statistics _ _
Additional tean b amirnumn decimal
Flots Standard deviation _ S
[ P T _

Tryk derefter Run, og felgende output kommer frem. Du skal maske lige vente et par sekunder,
og mens du gor det, kan du nederst til venstre i skeermbilledet se status pd SAS’ beregninger:

ﬁ;[ﬁetailsl Funning: Summary Skatistics1 - Running. ..

Derefter fremkommer en fane, der hedder Results med vores output fra analysen. I outputtet
nedenfor kan du aflese grundleggende beskrivende statistik om talvariablene:

Summary Skatistics - X

ﬂ Input Data rl Code j Lag %] Fesults
{5 Refresh mMudiFy Task | Export = Send To = Create - Properties

Summary Statistics
Results
The MEANS Procedure

Variable, Mean Std Dev Minimum Maximum N
kontantp 226532 B806.32 09500  4700.00 B9
boligst 104 54 a0.24 a0.00 357.00 B9
grundst 04680 511.13 380,00  3221.00 B9
vagrelse 3.80 1.22 1.00 a8.00 /9

Af outputtet ovenfor fremgar det bl.a., at gennemsnitsprisen pa de 69 boliger er 2.255 mio.
kr., og at den gennemsnitlige boligsterrelse pa disse 69 boliger er 164,5 m? Prov at se, om du
selv kan fortolke de ovrige gennemsnitsvaerdier pa samme made.2

2.2.3. Visualisér data og tjek, om en variabel er normalfordelt

Ofte vil man gerne bruge statistik til at konkludere noget generelt ud over bare at beskrive sin
stikprove. Fx kan det jo vere n®rliggende at prove, om man kan konkludere noget generelt om
boligmarkedet for huse i Kebenhavnsomradet i &r 2000 ud fra vores datasat. At generalisere
fra en stikpreve virker maske lidt risikabelt, men det er ikke desto mindre lige pracis det, som
er statistikkens hjemmebane. Tit er det enten for dyrt eller helt umuligt at undersoge alt.

2. Grundsterrelse pa ca. 950 m? og gennemsnitligt 3,8 veerelser.
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Histogram

Histogrammer er et af de hyppigst anvendte varktejer til at visualisere data. En forudsatning
for mange statistiske tests er, at vores intervalvariable er normalfordelte. Det kan man
ogsa let undersoge ved at lave et histogram, hvor normalfordelt data skal vere nogenlunde
“klokkeformet”. Man laver et histogram via dropdown-menuen Tasks > Describe > Distribution
Analysis... Her trekkes fx variablen kontantp over under Analysis variables-punktet, som det
er gjort nedenfor:

Jli; Distribution AnalysisZ for Local: WORK.BOLIGDATA

) D ata
Digtributions
Summary
Marmal Data source: LocalwWORK.BOLIGDATA
Lognormal Task filker: MHone
E xponential
Wheibull
Beta Yariables to assign: Task rales:
Gamma = . .
Kemel Hame 00 Analysiz variables
Plats ) r @ kaontantp
] Group analyziz b
ppsarance | | (b oeome o el

Klik herefter pa Distributions ude til venstre 1 dialogboksen og st flueben ved Normal. Dette
giver en normalfordelingskurve i histogrammet (nar du ser normalfordelingskurven, giver det
mening, hvad der menes med “klokkeformet™):

Data Distributions > Summary
Diztributions
Sumrmnary
Maormal Available diztributionz
Logrormal
Exponential Mormal

Derefter klikkes pa Plots ude til venstre, og et histogram valges:

I, Distribution Analysis2 for Local: WORK.BOLIGDATA

Data Plots > Appearance
Drigtributions
Summary
Marmal T o
Lognarmal I_‘ Histogram Plot B - .- 1
Exporential
Wwheibull K
Beta [] Piohahility Plat
[Famma
Kemel e
A [] Quantiles plat
Tables * * * []Box plat w
Titlez 3 »

Prarerties
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Klik nu Run, og der kommer et output frem, og nederst i det finder du et histogram ligesom
det nedenfor. Det viser, at boligpriserne er nogenlunde normalfordelte, men ikke helt perfekt.
Der er fx en tendens til, at der er flere meget dyre huse, end der skulle vaere, hvis data var helt
normalfordelt.

30

258

20

900 1500 2100 2700 3300 3900 4500
kantantp

I dialogboksen ovenfor kunne man ogsa have valgt et Probability Plot (PP plot), et Quantiles
Plot (QQ plot) eller et Box Plot. PP og QQ plots viser grundleggende det samme som
histogrammet (Et Box Plot vender vi tilbage til senere). Nedenfor er vist et QQ plot. For at
data er normalfordelt, skal den ligge teet op ad den skra linje

kontantp

5000

4000

3000

2000

1000

MNormal Quantiles

THE
POWER
TO KNOW.
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Som det ses af QQ-plottet, er der maske lidt problemer med, hvorvidt huspriserne er
normalfordelte — s@rligt med de laveste af de hejeste priser. Det var faktisk det samme, man
kunne se pa histogrammet tidligere, hvor der ogsa er en tendens til, at der s@rligt i den ovre ende
af prisskalaen er huse, der er sa dyre, at normalfordelingen ikke passer helt perfekt. Man siger,
at boligpriserne er hejreskave, hvilket bare betyder, at der er lidt flere observationer til hgjre
pa histogrammet, end man ville forvente, hvis observationerne fulgte normalfordelingskurven.

2.3. Tilpas dit dataseet til de analyser, du gerne vil lave

Ofte har man behov for at @ndre lidt i sit dataset, for man kan lave sine analyser. Man kalder
dette *"datamanipulation’, og det har altsa ikke noget at gore med at snyde med dataene. Det,
man gor, er fx at tage en variabel og gruppere den. Det er fx allerede gjort i vores boligdataszat
med variablen kvalitetgr, som forenkler kvalitetsvurderingen af boligerne fra fem grupper til
tre (1=lav, 2=middel, 3=hgj). Vi vil dog give grupperne navne i stedet for numre bare for at
vise, hvordan det gores.

Nar man @ndrer i sit dataset i SAS, sd @ndrer man ikke direkte i det originale datasat, men
man laver derimod en sakaldt Query i dialogboksen Query Builder. Dvs. man laver et sakaldt
dataudtrek fra sit oprindelige datasat, og sa tilfejer man nogle beregninger og rekodninger
baseret pa de eksisterende variable. Dette resulterer i et nyt dataset, som man sé kan lave sine
onskede analyser ud fra. Det er ret smart, for pad denne made @ndrer man ikke direkte 1 sit
oprindelige datast, og man kan lave mange forskellige dataudtrek fra det samme originale
og urorte datasaet. Og skulle det ske, at man havde brug for at opdatere noget i det originale
dataset, sa bliver alle dataudtrekkene og de afledte analyser automatisk opdateret med ét klik.
Det er altsa virkelig smart — bade for studerende, forskere og virksomheder, som gerne vil have
fleksibilitet og datasikkerhed samtidig.

Nar man laver et dataudtreek, starter man i Query Builder som nedenfor, og hvis man ensker at
bevare alle de originale variable, kan man starte med at markere alle variablene og trekke dem
over til hojre. Det er gjort pa billedet nedenfor, hvor alle variable bortset fra omr-variablen er
trukket over:

i Query Builder, for Local:BOLIGLIB.BOLIGDATA

Query name: | Queny Builder Output name:  wORK.QUERY_FOR_BOLIGDATA
E Computed Columns @ Prompk Manager | E2) Preview _ifg Toals = | ] Options =
54 Add Tables iy Join Tables || SelectData | Fiker Data | Sort Data
= Eg)[ BOLIGDATA ] Colurnn Mame |dentifier Summary
0
. 123 nr t1.nr
geografi . .
% kantanip @geagrafl t1.geografi
@ boligst @ kantantp t1.kontantp
) gundst iz boligst t1.bcligst
@ vasrelsa @ grundst t1. grundst
@_ arnr @ vaerelse t1.vaerelze
(@ kvalitet i) kvalitet 1 kvalitet
@ ke alitetgr @ kv alitetgr 11 kvalitetgr
< >
[] Select distinct rows anly
[ Run v] [ Save and Cloze ] [ Cancel l [ Help ]
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Vi kan ogsa lige specificere, at vores Query skal gemmes som et nyt datasat i vores library.
Det gores ved at trykke pd Change i overste hgjre hjorne af dialogboksen ovenfor og vaelge
Libraries > BOLIGLIB og derefter trykke Save (SAS foreslar selv at kalde datasattet for
QUERY_FOR_BOLIGDATA, hvilket er fint):

I~ Save File

Savein |[z) BOLIGLIE v & X Bl -

Servers arne Member Tppe  Indexed
EEOLIGDATA

Derved bliver vores nye datas®t fra denne Query gemt i vores library, som det ses til hgjre
nedenfor:

iy Query Builder, for Local:BOLIGLIB.BOLIGDATA

Queny name: | Query Builder Output name: | BOLIGLIB.QUERY_FOR_BOLIGDAT

Hvis man trykkede Run nu, ville der blive oprettet et nyt dataset som et dataudtrek fra
det oprindelige dataset. Det nye dataset ville veere helt identisk med det originale, bortset
fra at omr-variablen ville veere udeladt. Det ville jo vere ret uinteressant at lave et identisk
dataset, sa for at vise forskellige muligheder prover vi lige at lave lidt tilfejelser og @ndringer
1 vores dataudtrek. Disse tre eksempler er vist 1 de tre underafsnit. Vi vil prove at rekode
omradevariablen fra 1 og 2 til Nord og Syd (underafsnit 2.3.1) og pd samme made lave en
dummyvariabel (2.3.2). Vi vil ogsa gruppere kontantprisvariablen i tre grupper: lav, middel og
hoj (2.3.3) og beregne kvadratmeterprisen for boligerne som en ny variabel i vores nye datasat
(2.3.4). Sluttelig vil vi prove at lave en logaritmisk transformering af en variabel (2.3.5).

2.3.1. Rekodning af en variabel

Forst vil vi @ndre tallene / og 2 for omradevariablen til hhv. Nord og Syd.

Vi trykker derfor pa Computed Columns everst til venstre i figuren ovenfor. Herefter trykkes
der pa New... og vaelges Recoded column som vist nedenfor:

| x|

Calumn Details Mew...

New Computed Column

1 of5  Selectatype

) Summarized columnn
(%) Recoded column

() Advanced expression
Add hew cong

From an exizting computed column
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Da det er omradevariablen, vi forst vil rekode, velges denne som vist nedenfor. Man skal lige
scrolle lidt ned for at kunne valge den, for omr er ikke med i de overste variable, da vi jo ikke
har specificeret, at vi gerne vil have den med i det nye datasat. Tryk derefter pa Next:

2 ofb  Selectacolumn

@ grundst

@ vaerelze

@ b alitet

il kvalitetar

—-E7 Guery Builder
- EEE 11 [BOLIGDATA |

@ nr
@ geografi

kontantp
boligat
3 grundst
) waerelse
HE
@ kwalitet

iz kvalitetar

@@

J

GRS

Herefter trykkes der pa Add... i dialogboksen nedenfor for at tilfeje en omkodning:

New Computed Column X |
3 afs Specify a replacement Ssas

Fieplacement Other values

Replace With Feplace all other values with:

*

(%) The curent value
1 A missing value

() Specify a valus:

Encloze walue in quotes

Calurin twpe
(%) Charactes
Add... 7 MWumeric
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P4 den nye dialogboks, der kommer op, trykkes igen pa den nye Add-knap, og derefter indtastes
verdien / i det linjerede felt, og nederst skrives Nord. Dette vil erstatte omrade / med det mere
sigende Nord i vores nye dataszat.

Replace Values | Replace a Range | Replace Condition

1

Witk thiz walue:

Maord E]

Encloze thiz value in quates

| ok || cancel || Hep |

Det er vigtigt, at der er sat flueben under der, hvor Nord star, da det angiver, at denne nye
rekodede variabel er en bogstavsvariabel og ikke en talvariabel, som den gamle variabel omr
var det.

Tryk derefter pa OK, og rekodningen fremgar af dialogboksen.

Proceduren gentages for 2 og Syd (pa helt samme made, sa det er ikke vist igen). Nar begge
rekodninger er lavet, ser det ud som nedenfor:

3 ofs Specify a replacement SS&S

Replacerment Other values
Replace With Feplace all other values with:
=1 Mard" (%) The curent value
=2 Spd'

0 A missing value

) Specify a value:

Encloze walue in quotes

Column type
(%) Character

Add... ) Mumeric
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Herefter trykkes pa Next, og vores Identifier for rekodningsindtastningerne samt Column Name
for den nye variabel navngives som nedenfor. Vi kalder Identifier for ’Omrdde re-kodning’, og
Column Name for omr_ny’:

Side 23

|
\_j Formats
Cateqgories: Formats:
2 of3 Modify additional options Ssas JBASER, A
Characte $BID 1w,
Uszer Defined
|dentifier: Ormrade re-kodning Al
Column Name: | omi_ny .
$FREEw. )
Label:
Attributes
Summary: HOME A Length (in bytes] Orverall width: 4 S Min 1 Max 32767
Expression; CASE Decimal places:

WHEM 1" = t.omr THEM 'Mord"
WHEN '2' = t.omr THEM "Spd'
ELSE t1.omr

Description
characters with blanks

END
E xample
Farmat: $CHART. \D’Z'tﬁt IEIIEII
[ <Back 'l[ Mexts ][ Finizh ][ Cancel l[ Help ]

Her kommer lige en lille sidebemarkning om valgmuligheden Format ovenfor (der hvor der
nu som standard er valgt SCHARI.). SAS er ret avanceret, nar det kommer til at handtere
forskellige tekst- og nummerformater. Grunden til, at det er smart, er, at man kan styre,
hvor meget dataplads hver celle i et dataset ma fylde. Det betyder ikke noget i sma datasat
som vores, men hvis man arbejder professionelt med kempe datasaet — fx i forbindelse med
aktieanalyser, medicinske forskningsprojekter eller beregninger i et forsikringsselskab — sa
betyder det faktisk en hel del for, hvor hurtigt beregningerne korer. Glem alt om at prove at
huske disse formater — man finder ud af, hvad man skal bruge, nr man féar brug for det. Men
her og nu kan du se, at der star §CHARI. ovenfor, og det et character (bogstav)-format, hvilket
er fint. 1-tallet betyder dog, at der kun er én dataplads, s derfor vil syd blive til s og nord til
n. Det duer ikke, sa vi skal lige have @ndret det til flere datapladser. Tryk derfor Change... i
billedet ovenfor og endr Attributes: Overall width til 4 og tryk derefter OK. Nu kan du se, at
formatet er ®ndret som nedenfor:

Format: FCHARA.

Tryk herefter pa Finish > Close
Den nye rekodede variabel star nu nederst pa listen over de variable, der vil vere i vores nye

datasaet:

Select Data | Filer Data | Sort Data

Calurnt M arne Identifier Surnrnary
@ tir .
{f{} geografi H.geografi
@ kontantp 1. kontantp
23 boligst 1. baligst
@ grundst 1. grundst
i vaerelze . vaerelse
{23 kvalitet H kevalitet
@ lxealitetar 11 kwalitetgr
T OITL_F1 Orréde re-kodning
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Hvis du trykker Run nu, kan du se den nye omr_ny-variabel i vores nye dataset:

agram  Tools  Help 'gv[é'-' A=) By - gqurocessFIow -

Query Builder ~

E53 Input Data|| (] Code | (2] Log Efd Output Data
'ﬁj IIlMDdiFy Task ﬁ,ﬁlter and Sort ﬂ_a-lQuery Builder | Data = Describe = Graph - Analyze = | Export » Send To -

@ nr "j geografi @ kontantp @ boligst @ grundst @ vaerelse @ kvalitet @ kvalitetor Lf‘) om_ny
1 1[Brandby 9595 150 B35 2 1 1 Syd
2 2 BrandbyStrand 1478 105 B30 3 3 2 Syd
3_ 3 Espergeerde a0 278 1815 B 2 1 Mord
4_ 4 Espergzerde 22580 203 885 4 3 2 Mord
5_ 5 Espergzerde 1885 130 627 3 3 2 Mord
B_ B Espergzerde 1835 169 702 3 3 2 Mord
Bl 7 Espergeerde 2595 167 E94 3 4 3 Mord
R | 8 Esperaserde 2100 133 951 2 3 2 Mord

Vi er dog ikke helt feerdige med @ndringer og tilfejelser til vores nye datasat. Sa derfor kan vi
gé tilbage og @ndre i vores Query ved at trykke pa knappen Modify Task, som du ser lige over
datasattet i venstre side af billedet ovenfor. P4 den made kan vi komme tilbage til den task,
som vi netop har udfert (vores Query), og korrigere / lave tilfojelser.

Det samme kunne man gore ved at trykke p& Process Flow-knappen (alleroverst midt for

1 billedet ovenfor) og derefter hegjreklikke pad Query Builder-ikonet og velge Modify Query
Builder, som det er vist nedenfor:

Process Flow -

[+ Run - Export + Schedule = | Zoom - f}Project Log Properties -
<@
X-—ef > -
Boligdata... Irmport Data Summary SAS Report
Data [Bol.. Imported ... Statiztics - Summar...
dlli =
ur ]
Diistribut... SAS Report
Analyzisl - Distrib..

[

Buildg [+ Run Query Builder

| |I|~ Modify Query Builder

Med denne lille ”SAS-sightseeing” er vi nu klar til at ga videre.

2.3.2. Lav en dummyvariabel

En dummyvariabel er en variabel, som enten er O eller 1. Her vil vi preve at lave en
dummyvariabel, som har verdien 1 for alle de boliger, som er i kvalitetsgruppe 3 (dvs. de
boliger med den hgjeste herlighedsvaerdi) og vardien O for de andre kvalitetsgrupper.

Man laver en dummyvariabel efter samme fremgangsmade som i eksemplet ovenfor
(underafsnit 2.3.1). Det gar bare lidt hurtigere, ndr man kun behever at indtaste én betingelse
1 kodning. Nedenfor opsummeres de forskellige steps, man skal igennem.

I samme Query Builder som 1 forrige underafsnit vaelges Computed Columns > New... >
Recoded Column > Next.
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Herefter vaelges variablen kvalitetgr (det er ligegyldigt, om du velger den i den everste eller
nederste tabel). Velg nu Add... > Add og skriv 3 som den vardi, der skal rekodes. I feltet
With this value skrives I for at angive, at verdien 3 (hej herlighedsvardi) skal vere 1 i vores
dummyvariabel. Tryk nu pad OK.

Nu mangler vi bare at specificere, at alle andre verdier af variablen kvalitetgr skal vere 0. Det
gores til hejre 1 billedet nedenfor ved under Other values at velge Specify a value og skrive 0.
Med disse indstillinger far alle boliger med hej herlighedsvardi et 1-tal 1 den nye variabel, og
alle ovrige boliger far et 0. Indstillingerne ser ud som nedenfor:

Replacement Other walues
Replace “ufith Feplace all ather values with:
=3 1 ) The curent value

1 A miszing value

(%) Specify a value;

0 L]

] Enclose value in quotes

Tryk nu Next og navngiv derefter den nye variabel til X dummy_hojkvalitet (du kan bare bruge
det samme navn til bade Identifier og Column Name).

Tryk Finish, og den nye dummyvariabel fremgar af listen Computed Columns:

o dummy_hajlvalitet CASE “WHEM 3 =t1.kwalitetar THEM 1 ELS...

Tryk Close, og vier klar til at g& videre. Hvis du trykker Run for at se resultatet (det behever du
ikke at gore), kan du bare sige Yes til sporgsmalet, om du vil overskrive det tidligere resultat.
Ellers kommer der et nyt dataset, og det er jo ikke meningen:

S5AS Enterprise Guide E]

b Do waou want ko replace the resules from the previous run?

</

Chaoosing "Mo" will save the changes to a new task, named "Query Builder2”,

I Yes I [ 0a] ] [ Cancel

Skulle du ved en fejl komme til at sige No, er det ikke vaerre end, at du bare kan hejreklikke
pa elementerne i Process Flow-diagrammet og velge at slette dem. Bare husk, at det sa er den
gamle version, du far slettet.
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2.3.3. Gruppering af en variabel

Herefter vil vi gruppere kontantp til en ny variabel, som enten er lav, middel eller hej, hvor alle
huse under 1,5 mio. kr. kommer i prisgruppe lav, huse mellem 1,5 og 2,5 mio. kr. kommer i
prisgruppe middel, og huse over 2,5 mio. kr. kommer i prisgruppe hej.

Dette gores pa nasten samme made som rekodningen, s du skal igennem de samme
indledende steps som ovenfor (start med samme Query som sidst og tryk pad Computed
Column-knappen, og herefter skal du vaelge kontantp pa listen over variablen). Det eneste, der
her er lidt anderledes, er, at man efter at have trykket Add... forste gang skal veelge Replace a
Range, som det er gjort nedenfor:

Specify a Replacement \3
Feplace Values | Replace aRange | Replace Condition

[] Set a lower limit:

Set an upper limit:

1500 (+]

With this walue:

lav (-]

Encloze this value in quotes

Som det ses ovenfor, er forste gruppe /av defineret ved veerdier af kontantp under 1500 (altsa
1,5 mio. kr.). Denne gang skal du selv huske at sette flueben ud for Enclose this value in quotes
under der, hvor du har skrevet ’lav’.

Tryk herefter OK og gentag for prisgruppe middel (lower limit: 1501 og upper limit 2500) og til
sidst for prisgruppen hoj (lower limit: 2501 og ingen ovre grense).
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Vi mangler bare lige at angive, at den nye variabel er en Character-variabel, fordi tallene for
boligpriserne erstattes af en kategori. Dette angives nederst til hojre i billedet nedenfor:

1 aof2 Specifty a replacement Ssas

Fieplacement Other values
Replace YWith Feplace all other values with:
<=1500 lan The current value
== 2ZA b . o
15012500 rniddel (2 A mizsing value

) Specify a value:

Encloze value in quotes

Calurnm type
(%) Character

Add... 3 Mumeric

[cres ) [

Tryk herefter pa Next og navngiv den nye variabel som kontantp_gr og giv dine indstillinger et
navn (Identifier), fx ’Kontantpris gruppering’.

Denne gang er du nedt til at @ndre formatet til et tekstformat. Tryk derfor Change... til hojre
for Format-linjen 1 det venstre billede ovenfor og velg derefter Character > SCHARw. og
tryk s4 OK. Nu er den nye omradevariabels format @ndret til et tekstformat med plads til
12 bogstaver. Du kan ogsa bare direkte skrive SCHARI2. i Format-feltet som pa billedet
nedenfor (husk punktummet efter 12-tallet, hvis du selv skriver det!). Hvorfor lige 12? Godt
sporgsmal — 6 havde veret nok ('middel’ er det leengste navn med 6 bogstaver), men man
gider jo ikke telle hver gang — vi har allerede sparet meget dataplads ved at tage stilling til
formatet, som fx i Excel som standard er 256 datapladser! Og sparet dataplads betyder, at
vores beregninger korer hurtigere:

Formats
2 of3 Modify additional options S Sas Categories: Farmats:
MNone FBASEBLm. A~
Character $BID .
Identifier: Kontantpris gruppering EHSEI Defined W'
FCPTDW .
Column Mame: | kontantp_agr FCPT WD,
$FREE Ci.
Label: FFREEw. hd
- Altributes
Summary: HOME w Length [in bytes]: =
DOverall width: 12 T Mirc 1 Max 32767
BT CASE Decimal places:
WHEN t1. kontantp <= 1500 THEN 'lav'
WHEM t1.kontantp »= 2501 THEN ‘haj' Diescription
WHEN 11 kontantp »= 1501 AND t1. kontantp <= 2500 THEM 'middel .
END characters with blanks
Example
Format: STHARTZ. Value: A ENES
Output  [JATBICT TAET T T T T
[ <Back '] [ Mexts ] [ Finish ] [ Cancel ] [ Help ]

Tryk herefter pa Finish > Close, og vores variabelgruppering er ferdig.
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2.3.4. Beregning af en ny variabel

Vi vil nu beregne kvadratmeterprisen for de forskellige boliger, og kvadratmeterprisen vil sa
blive en del af datasattet som en ny variabel i en ny kolonne. Den beregnes som kontantprisen
divideret med boligstorrelsen. Vi starter med at trykke pa Computed Columns og vealger
Advanced expression som gjort nedenfor:

1 ofd  Selectatype Ssas

) Summarized colurh
) Recoded colurn
(3) Advanced expression

) Fram an existing computed column

Tryk derefter pa Next, og nedenstaende formel-editor fremkommer:

New Computed Column X |
2 of4 Build an advanced expression Ssas

Enter an expression:

Edit - Favorites »  Yalidate

+ - F ¥ ) % "', abch
+-[_| Functions
=[] Tahles
b3 1 [BOLIGDATA]
+ -4 Selected Columng
+ @ Computed Columns

[<Back '][ Mext: ] [ Cancel H Help ]

Klik pé det lille kryds til venstre for vores dataset ¢/ (BOLIGDATA)” og dobbeltklik sa
pa variablen kontantp. Tryk dernast pa knappen med divider-symbolet (/) og dobbeltklik pa
variablen boligst. Din formel skulle gerne se ud som nedenstdende nu:

Enter an expreszion:

t1. kontantp # t1.baligs

Tryk nu pad Next og navngiv beregningen og den nye variabel som nedenfor:

Identifier: Beregning af kvadratmeterprizer

Column Mame: | kvmpriz
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Tryk nu pé Finish og derefter pa Close.

Nu kan du se, at den nye beregnede variabel fremgar pa listen af variable, der vil vaere med i
det nye datasat, som Query Builder’en laver:

iy Query Builder for Local:BOLIGLIB.BOLIGDATA

EIRE |\ ..., Eilcer Output name: | BOLIGLIE.QUERY_FOR_BOLIGDAT

] Computed Columns | £ Prompt Manager | 2] Preview E&Tools » | [ Optians -

FH Add Tables X Delete EgJoin Tables || Select Data | Fiter Data | Sort Data
= 711 (BOLIGDATA]

O Column Mame Identifier Summary
2 nr
\ . 13 1.
£ geografi @ i . Ll '
= £, geografi 1. geografi
@ kantantp
@ holigst @ kortantp 11 kontantp
i
@ grundst @ boligst 11.boligst
@ vaerele @ grundst 11, grundst
i omr i) vaerelse . vaerelse
i kvalitet 2 kvalitet 1 kvalitet
120 kwvalitetgr @kvalitetgr 1 _kevalitetgr
= Computed Calumns Ty CTIT_pY Orrdde re-kadning
%o Omrdde re-kodning o kontantp_ar Kaontanpris gruppe. ..
%o Fontanpriz gruppering Yo dummy_hejkwval...  dummy_haiksalitet
| Beregning af kvadratmeter priser H kvmpris Beregning af kvad...

oo durnmy_hejkvalitet
< >

[ Select distinct rows only

[ Run vl[ Save and Close H Cancel ][ Help

Hvis du trykker Run nu, sd fremkommer et nyt dataset, hvor de valgte og konstruerede
variable er med (kun de forste par raekker vises nedenfor):

Query Builder -

Eid Input Data fl Code | ] Log Erd Output Data
GS IﬂModiFy Task %}‘ﬁ,Filter and Sort f&lQuery Builder | Data = Describe = Graph = Analyze = | Export = Send To =
@ nr |é‘» geografi @ konlarlp@ holigsl@ grundst @ vaemlse@ kvalitet @ kvalilelg|é§ omr_ny |é‘» kontantp gri/2!  kvmpris
2

1 1 Brondby 935 150 B35 1 1 Spd la 66333333333
2 2 BrondbySha.. 1478 108 B30 3 3 2 Spd la 14.076190476
3 3 Espergesrde 3100 278 1815 & 2 1 Mard haj 11151079137
4 4 Eszpergaerde 2250 203 485 4 3 2 Mord middel 11.083743842
L 5 Espergaerde 1885 130 B27 3 3 2 Mord middel 145
(] 6 Espergaerde 1835 169 702 3 3 2 Nord middel 11213017751
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I Process Flow-diagrammet er det nye datasaet Query for boligdata ogsa kommet frem nederst
til hejre. Det er det dataset, vi vil bruge som udgangspunkt for analyserne senere i denne

e-bog:

x]

Boligdata...

L 3

==

Irmpart
[Data [Bal...

L 3
b

-2 — 1

Data Summary S5A5 Report
Imparted ... Statiztics - Summar...
il ——
me |
Diistribut... SAS Repart
Analysiz] - Diztrib....
i -—— 52
e
Cuery QUERY_FOR. .
Builder

2.3.5. Transformering af en variabel

Hvis en variabel ikke er helt normalfordelt, som det fx er tilfeeldet for boligpriserne, s& kan
man velge flere forskellige tilgange. Man kan fx preve at ’transformere’ variablen, sa den
bliver normalfordelt ved at tage den naturlige logaritme til variablen /n(kontantp).

In(kontantp ) beregnes samme sted som beregningerne ovenfor. Formel kommer til at se sddan
ud. (LOG( ) beregner den naturlige logaritme med grundtal e):

Enter an expression;

LOG[H kontantp]

Hvis du prever at beregne In(kontantp), sa serg for, at du ogsa har den originale variabel
kontantp med over i dit nye dataset, for det er den, vi for enkelhedens skyld vil bruge i resten
af denne e-bog, selvom In(kontantp ) maske ville veere mere korrekt.
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2.4. Begraens dit datasast

Nogle gange er man kun interesseret i at analysere nogle dele af sit datasat. Det kan fx vere,
at du har besluttet dig for, at du helst vil bo syd for Kebenhavn, da du netop har faet job i det
omrade. Sa ville det jo vere smart at begreense analysen af dataseattet til kun at omfatte de
boliger, der ligger i det omrade. Det kan let gores i SAS ved at legge et “filter” pa dataseattet.

I Process Flow-diagrammet kan du hejreklikke pa det dataset, du fik som resultat i forrige
afsnit (hvis du ikke har fulgt forrige afsnit, sa kan du finde datasattet pA www.sasacademic.dk
samme sted, som du fandt denne e-bog). Nar du hejreklikker pa et dataseet, far du muligheden
for at filtrere datasettet (Filter and Sort...):

HEIEE e
S [ Open
Huery QUERY_
Builder BOLIGD, Export 4

4 Filter and Sart...,
By Query Buider. .,

Forst treekker du alle variablene over til hejre (brug evt. denne tast [ 5 )

1—% Filter and Sort for Local: WORK.QUERY FOR_BOLIGDATA

B Variables | 52 Fiter | 20 Sort| B Resuls

Available [0): Selected (17 of 1]
| eI | Harme Tupe Lahel -
_'> 2 A Murn nr
Ep .-@_-. geografi Char geograli
@ kontantp Mur kontantp
@ boligst MHum boligst
@ grundst MHum grundst
i) vaereke Murmn vaerelse
F T Bluann Louo=libmt %
£ >

Derefter velger du everst i dialogboksen Filter-fanen og velger omr_ny-variablen, som du
angiver, skal vere Equal to en given verdi. For at valge, hvad omr_ny skal vaere equal to,
trykker du pé& knappen [ .. |, hvorefter valgmulighederne fremkommer. Her valger du Syd
som vist nedenfor (hvis man har flere/andre variable, der skal filtreres pa, kan man velge
dropdown-boksen til venstre for knappen [¥ |). Tryk derefter OK:

F-J-l-l-l
T4

) variables | % Fiker ) Sart| & Results

Filker desgcnption:

arir_ny “ | | Equaltao ~ E]

Select a zingle value:

Waluez  Formatted Walues
Mord Mord

Osas



STATISTIK MED SAS®
Side 32

Tryk OK endnu en gang, og det filtrerede dataszt fremkommer, hvor kun huse syd for
Kebenhavn indgar (kun de forste raekker vises nedenfor):

i) o |/ geografi /) kontanlp |2 boligst 2 grundst 2 vaerelse () kvalitet (2 kvalitetgr /. omr_np |/ kontantp or /i@ kvmpris
B 3 &
150 B35

1 1 Brandby 995 2 1 1 Syd lav E.E333333333
2 2 BrondbyStrand 1478 108 B30 3 3 2 Syd lav 14.076130476
3 10 Greve 3335 m e 4 4 3 Syd haj 35,99033033
4 11 Greve 4200 173 736 B 5 3 Syd haj 23 463687151
5 12 Greve 1655 148 75 3 2 1 Syd midded 10524657534
6 13 Greve 1450 144 TEE 3 1 1 Syd lav 10.069444444
7 14 Greve 1235 a1 850 2 2 1 Syd lav 15987654321
8 15 Greve 1855 168 Tod 3 3 2 Syd midded 11.424848405
9 16 Greve 1455 138 &l 3 2 1 Syd lav 11.074074074

Man kunne ogsa sortere det filtrerede datasaet — det kunne fx vere, at man gerne ville se de
billigste huse overst og dyreste nederst. Det gores via den tredje fane i dialogboksen fra Filter
and Sort... (er ikke gjort her).

Det nye filtrerede dataset hedder Filter_for_query_for_boligdata” og fremgar af Process
Flow-diagrammet:

EJI:LLI i u‘ = B u'
Quesry QUERY_FOR... Filker and FILTER_FO...
Builder Sart

Det navn er jo lidt klodset, s man kan @ndre det ved at hejreklikke pa Filter and Sort og
veelge Modify Filter and Sort. Der kan man overst velge fanen Results, hvor man har mulighed
for at @ndre navnet pa det producerede datasat. Her er det kaldet Work. Boliger_i_Syd, sa
dataudtrekket ikke gemmes permanent, men i det midlertidige /ibrary, der hedder WORK:

#h Filter and Sort for Local:WORK.QUERY_FOR_BOLIGDATA

B Variables | g Fiter| 20 S| & Resuls

Task name:
Filker and Sort

Dutput narne:

WORK. Boliger_i_Sud

Tryk derefter pa Save > OK, og navnet er nu @ndret:

B N-==
?—J} ﬂ:
Filter and Boliger_i_
Sart Syd
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DET MEST ANVENDTE

STATISTIK | PRAKSIS

Noget af det, man ofte vil i statistik, er at teste, om nogle antagelser holder i praksis. Man
kalder det hypotesetests. En statistisk hypotese formuleres som en pastand, som man enten
kan forkaste eller ikke forkaste. Hvis man forkaster hypotesen, konkluderer man, at den var
forkert. Hvis man ikke forkaster hypotesen, si siger man, at man ikke kan sige, at den var
forkert — men altsé heller ikke, at den er entydigt rigtig.

Ud over hypotesetestser den anden grundleggende statistiske teknik at lave konfidensintervaller,
og dem kommer dette kapitel ogsa ind pa.

En gruppe af hypoteser beskaftiger sig med test pa gennemsnit, og blandt dem finder man
t-tests og ANOVA-tests (afsnit 3.1). Hvis data er nominel (grupper), kan man ikke beregne
gennemsnit. Derfor beregner man tit andele/procenter i stedet, og man kalder disse tests for
test pa andele eller test pa datatabeller (begge dele behandles i afsnit 3.2). En anden ofte brugt
teknik er regressionsanalyse. Fx giver det god mening at antage, at huspriser til en vis grad kan
forklares af boligsterrelsen, og dette kan man lave en model for med en regressionsanalyse
(afsnit 3.3). Nogle gange vil man gerne teste noget i forhold til en given statistisk fordeling.
Sadanne tests kaldes fordelingstests, og denne e-bog viser med et par eksempler, hvordan disse
laves i SAS for bl.a. binomialfordelingen og normalfordelingen (afsnit 3.4).

OBS: I resten af denne e-bog anvendes datasettet 'Query for Boligdata’ til analyserne. Det er det
dataset, der er resultatet af afsnit 2.3. Datascettet "Query for Boligdata’ kan ogsda downloades
fra www.sasacademic.dk (samme sted, som du kan downloade denne e-bog) og kan dbnes direkte
i SAS via 'File > New > Data’ som vist nedenfor:

f€ SAS Enterprise Guide

File | Edit  ‘iew Tasks Program  Tools  Help % 7 E' %
|§ Mew 4 | @ Project
-
[k Cpen ’ ||_’1 Data |
"lmea Dvmiark =

B Open Data

Browse | Search SAS Folders [ SAS Enterprise Guide
Lackin: |5 Desktop v ¢ File  Edit  “iew  Tasks  Program Tt
i - Process Flow -
@ Deskiop LMy Documents Plisee iss *
j My Computer :Qg Process Flow
() My Dacuments & My Mebwork Places EEE query_for_boligdata
: e ¥Mware Shared Folders e
$ My Computer )54 Prajects i % i
@ ) My Netwark BDIigdata.xst el
~ Places FEflquery_For_boligdata, sas7hdat query_far...
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3.1. Test pa4 gennemsnit (means)

Dette afsnit viser forst, hvordan man tester ét gennemsnit (underafsnit 3.1.1) og derefter test
pa forskellen mellem to uafhangige gennemsnit (3.1.2). Test pa parvise stikprover beskrives
ogsa (3.1.3). Nar 3 eller flere grupper skal sammenlignes, anvendes ANOVA-tests (3.1.4), og
hvis to faktorer skal testes samtidig, anvendes Two-Factor ANOVA (3.1.5). De enkelte tests
introduceres yderligere i begyndelsen af deres egne underafsnit.

3.1.1.Test for ét gennemsnit (One sample t-test)

Lad os antage, at du har skimmet boligdatasattet igennem og har en fornemmelse af, at
husenes storrelse gennemsnitlig er pd 150 m2 Denne antagelse kan du let teste i SAS. Du
starter i Process Flow-diagrammet og dobbeltklikker pa det datasat, du gerne vil arbejde med
— i vores tilfelde datasettet Query for Boligdata. Her velger du menuen Analyse > ANOVA >
t Test... som vist pa billedet nedenfor:

QUERY_FOR_BOLIGDATA -

i Filker and Sort. B Query Builder | Data = Describe ~ Graph - | Analyze -| Export + Send To -
@ nr |{_‘_;. geografi @ kontanip @ | ANMOYE, 3 ||ﬂ k Test,..
1 1 Brandby 335 Regression P One-Way AROVA...
2 2 BrondbyStrand 1478 . v L i
3 3 Espergasrde T A% Monparametric One-\Way ANCOYA,
4 4 Espergeerde 2260 Survival Analysis » | %5 Linear Models. ..
5 5 Espergeerde 1885 Capability v | Mixed Models...
[ £ Ezpergearde 1895 - e
= s o . Len anbenl Charke v b

Velg One Sample som testtype:

I t Test for Local: WORK.QUERY_FOR_BOLIGDATA

t Test type
Data
Analyziz
Plots
Titles
Properties

t Test type

Chooze t Test type:
) Twao Sample

) Paired

+) One Sample

> S

Klik derefter pad Data og flyt variablen boligst over som Analysis variables:

t Test type Data
Data
Analyziz
Plats Data source:  LocalWORK.QUERY_FOR_BOLIGDATA
Titles Task filter: Mohe
Properties
Wanables to azsign: Tazk roles:
M arne i) Analysis variables
= R boligst )
{:") geografi 4_3" Group analyzis by -
@ kartantp i Frequency count [Limit: 1]
@ ol i Relative weight [Limit: 1)
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Klik derefter pd Analysis ude til venstre og angiv, at den verdi, vi tester, er 150 (vi ville jo
gerne teste, om boligerne gennemsnitlig er ca. 150 m?). Det bliver formuleret som, at vores
nulhypotese er HO: u=150 med alternativhypotesen H1: p. Som det fremgar pa Confidence
level, er niveauet som standard 95%, hvilket svarer til et signifikansniveau pa 5% (o = 0,05).

t Test type Analysis
Data
Analyziz
Plots Full hypothesis
Titles Specify the test value for the null hypothesis:
Properties
Ho = 180

Standard deviation confidence intervals

E qual tailed

[ UMPU [Upifarmaly most powerful unbiased test)

Confidence level: qR3 w

Under Plots veelges Confidence interval plot som nedenfor:

t Test type Plots
Data

Analysis
Plats
Titles
Froperties

Types

[] Summary plot

[] Histogram

[]Baox plat

Confidence interval plot

[C] Marmal quantile-quantile (3-3) plat

Osas



STATISTIK MED SAS®

Tryk derefter Run, og der kommer et output frem som nedenfor:

T1est
The TTEST Procedure

Variable: boligst

‘ N/Mean Std Dev Std Err Minimum Maximum
69 1645 502437 60486 800000 3570,

‘Mean 95% CL Mean Std Dev 95% CL Std Dev
11645 1525 1766 502437 430351 60.3756

DF t Value Pr > |t}
' B8 240 09190,

Mean of boligst
With 85% Confidence Interva

< Mean

155 160 165 170 175
boligst

Af outputtet fremgar det, at den gennemsnitlige boligsterrelse er 164,5 (mean), og at
p-verdien er 0,019 (Pr>[tl). Da p-vardien er mindre end vores a-niveau pa 0,05, forkastes
HO, og vi konkluderer, at den gennemsnitlige boligsterrelse ikke er 150 m?. Vores data
indikerer endvidere, at gennemsnittet er hojere end de 150m?. 95% af konfidensintervallet
for den gennemsnitlige boligsterrelse ligger jf. plottet ovenfor ca. mellem 152 m? og 177 m?,
sd vi er 95% sikre pa, at den sande gennemsnitsboligsterrelse for alle huse nord og syd for
Kebenhavn ligger i dette interval. Mere pracist kan vi ogsd aflese konfidensintervallet i
tabellen i outputtet, hvor der star, at den nedre grense er 152,5, og den ovre graense er 176,6.
Hvis man vil regne det ud selv for at tjekke, at det passer, kan man sige 164,5 = (2 - 6,0486),
hvor de 6,0486 er standardafvigelsen af gennemsnittet fra outputtet (Std. Error), og de 2 er
en tommelfingerregel for konfidensintervallets bredde, ndr a=0,05 og testintervallet er tosidet.

3.1.2. Test af forskellen mellem to uafh@ngige gennemsnit (og varianser)
Man kunne godt fa den tanke, at der méske er forskel pa prisen af husene, der ligger hhv. nord
og syd for Kebenhavn. I vores stikpreve fra boligmarkedet er der bade huse fra nord og syd,

sa vi kan let teste, om der er forskel.

Start pd samme made som i forrige test med at dbne datasettet Query for boligdata og velg
Analyze > ANOVA > t Test...

Standardindstillingen med Two Sample er helt fin i dette tilfelde, da vijo ensker at ssmmenligne
to grupper — nord vs. syd.

b Test type

t Test type
Data
Analyziz
Flots Choose t Test type:
Titlez

. (%) Two Sample
Properties A
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Tryk derefter pa Data ude til venstre og flyt variablen omr_ny over som klassifikationsvariabel
og variablen kontantp over som analysevariabel, som det er gjort pé billedet nedenfor:

t Test type

Data
Data
Analysiz
Plats Data zource:  LocalwORK.QUERY_FOR_BOLIGDATA
Titles T azk: filker: MHone
Properties
Yariables to azzign: T azk roles:
MHame 4 Clazsification wariable [Lirit: 1
@ Fir .{:_;_ Qrnr_ry
A geografi i .T’-'-.naiial:ules
@ antantp @ Aulgle=igiin]

5 Rrann analusiz ho

Under Analysis ude til venstre @ndrer vi ikke noget. At testvaerdien for analysen er 0 betyder,
at vi vil undersoge, om forskellen pa gennemsnitsprisen af huse i hhv. nord og syd er lig med 0
(altsa at der ikke er nogen forskel p4 gennemsnittene). Dette er vores H -hypotese:

b Test lype Analysis
Data
Plats Hull hypothesiz
Titles Specify the test value for the null hypathesis:
Properties
Hao = 0
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Under Plots ude til venstre velger vi som i forrige eksempel Confidence interval plot. Tryk
herefter pad Run, og nedenstaende output fremkommer:

Variahle: kontantp

omr ny | N Mean| Std Dev Std Err Minimum Maximum
Nord 39 24291 7835 1263 1310.0 4700.0
Syd 30 20295 7852 1433 835.0 4200.0

Diff (1-2) 3996 7870 1911

omr_ny |Method Mean 95% CL Mean Std Dev 95% CL Std Dev
Nord 24291 735 26846 FEB5 B444 10162
Syd 0295 17363 2326 FBEZ  BXAI 10555
Diff (1-2) |Pooled 3996 18.0844 751.1 7870 B734 247 .2
Diff (1-2) Satterthwaite 3996 17.8132 7381.4

Method Variances DF tValue|Pr = |t

Pooled Equal B7 209 00404

Satterthwaite Unequal 62 .BE5 2.09 0.0405

Equality of Variances
Method | Num DF Den DF F Value| Pr=F
Folded F 38 2d 1.01 0.9933

Mean of kontantp Difference (Nord - Syd)
With 95% Confidence Intervals

< Meal
I Sattethwaite I
| |
I Fooled I

For vi fortolker, om der er signifikant forskel mellem priserne i nord og syd, skal vi lige huske,
at det er en foruds®tning for t-testen, at variansen er ens mellem de to grupper af huse, vi
tester. Det vil i praksis sige, at fx husene i nord ikke ma svinge voldsomt mere i pris end husene
isyd. Det tester SAS faktisk automatisk for os, og testresultatet er ovenfor i den nederste tabel,
der hedder Equality of Variances. Varianstestens H -hypotese er, at varianserne er ens mellem
de to grupper. Da p-verdien pa 0,9933 er meget hgjere end vores signifikansniveau o.=0,05,
kan vi ikke forkaste denne H, og derfor konkluderer vi, at denne forudsetning er opfyldt.

Nu kan vi sa ga videre til den hypotese, som vi oprindeligt ville teste: Er der forskel i
gennemsnitsprisen mellem nord og syd. Da vi lige har faet bekreaftet, at varianserne er ens,
sd afleser vi testresultatet i den tredje tabel fra oven under metoden Pooled (betyder, at
varianserne er pooled = lagt sammen, da de jo ikke er forskellige). P-vaerdien er 0,0404, hvilket
er lige under vores signifikansniveau 0=0,05, sa derfor konkluderer vi, at der er prisforskel
mellem gennemsnitsprisen pa huse hhv. nord og syd for Kebenhavn. Da p-verdien er meget
teet pa vores signifikansniveau, er konklusionen lidt usikker.
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I den overste tabel i outputtet ovenfor kan man se, at stikprovegennemsnitsprisen for huse
nord for Kebenhavn er 2,429 mio. kr., og at stikprevegennemsnitsprisen for huse syd for
Kebenhavn er 2,029 mio. kr. Dette betyder, at huse nord for Kebenhavn gennemsnitligt er
dyrere end huse syd for Kebenhavn. Men her skal man vere forsigtig med at begynde at
overfortolke testresultatet. Der kan vaere mange arsager til, at husene i nord gennemsnitligt
er dyrere end dem i syd. Maske er de gennemsnitligt sterre eller har gennemsnitligt hajere
herlighedsvardi end husene i syd. Det har vi jo slet ikke forholdt os til i denne enkle test. Det
kommer vi tilbage til.

3.1.3. Test af to parvise stikpreaver

Hvis man har parvise observationer — fx priser for de samme boliger i ar 2000 og i dag — s&
kan man teste pa forskellen. Det kalder man parvise stikprever, fordi observationerne passer
sammen to og to. Vores datasat er ikke oplagt til at teste pa parvise stikprever, men det kan
let gores, hvis datasattet tillader det. Test pa parvise stikprover udferes samme sted som de
to foregadende tests:

t Test type

t Test type
Data
Analyzis
F'!ots Choose b Test type:
Titlez . M | O TwoSample
Prapertiez

P

(%) Paired

() One Sample

15

I denne test skal man blot angive, hvilke to variable der herer sammen to og to:

Tazk rales:

i) Paired wariables [Limnit: 2]

Hvis vi fx havde boligpriserne pa de samme boliger i dag som en anden variabel, der hed
kontantp_nu, sd kunne man bruge den variabel sammen med variablen kontantp og derved
teste, om priserne generelt havde @ndret sig. Parvise tests er sterke rent statistisk, fordi de er
virkelig gode til at spotte @ndringer, som test for to uathangige stikprever ikke kan identificere.

3.1.4. Test flere gennemsnit med variansanalyse One-Way’ ANOVA)

Hvis man vil teste flere end to gennemsnit, s er det one way ANOVA, man skal bruge. ANOVA
er egentlig en forkortelse for Analysis of Variance, og det kan jo godt lyde lidt misvisende,
nar det er en test for gennemsnit, men sddan siger man altsa. Vi vil her preve at teste, om
der er forskel i boligprisen mellem de tre forskellige kvalitetsgrupper af boliger, dvs. om
herlighedsvardien pavirker boligprisen.
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Denne ANOVA-test gennemfores ved forst at dbne datasattet via Process Flow-diagrammet og
derefter veelge Analyze > ANOVA > One-Way ANOVA... Derved fremkommer nedenstaende
dialogboks, hvor variablen kontantp velges under Dependent variables, og variablen kvalitetgr
valges som Independent variable:

One-Way ANOVA for Local: WORK.QUERY FOR_BOLIGDATA

Data

Data
Tests
b eans
Comparizan [Data source: LocalwORK.QUERY_FOR_BOLIGDATA,
Breakdown T azk filter: MHone
Plots
Results
Titles Wariables to assign: Task oles:
Propetties M ame i Dependent variables
i3 e @ kontantp
@‘;,geugrafi 45 Independent wariable [Lirnit 1
@ kontantp @ kwalitetgr
8 helinst 45 Group analysiz by

Man kan i princippet trykke Run med det samme, hvorefter resultatet fremkommer. Man skal
dog lige huske at tjekke forudsatninger for testen forst. De er 1) varianshomogenitet og 2)
normalfordelte fejlled (residualer) fra ANOVA-testen.

*  Varianshomogenitet kan fx testes med Levene’s test, som man valger under menuen 7ests:

Drata

Tests

Means
Cormparizon
Breakdown [I'welch's vaniance-weighted ANOWA

Plats

Results )
Titles Tests for equal vanance

Tests

Properties
" [ Bartlett's test

[ Brown Forsythe test

* Vi har allerede indirekte tjekket normalfordelingen af residualerne ved at undersege, om
kontantp-variablen var normalfordelt (se underafsnit 2.2.3), sa det er godt nok her.

Ofte er det rart at fa visualiseret resultatet af en A NOVA-test, s& derfor vaelger vi et Box and
whiskers-plot under menuen Plots:

Data Plots
Tests
Means
Comparisan Types
Breakdown

Results ? é Bow and whisker
Titles

Pramerhies

Tryk nu p& Run, og du far dit output frem.
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Forst ser vi pd Levene’s test for varianshomogenitet. Vores H er, at der er varianshomogenitet,
altsa at der ikke er problemer med forskellig varians af huspriser mellem de tre grupper af
kvalitetgr-variablen. Da p-vardien pa 0,3527 er langt over vores signifikansniveau pa o.=0,05,
kan vi ikke forkaste HO og antager derfor, at der er varianshomogenitet. Dvs. foruds@tningen
for ANOVA-testen er opfyldt:

Levene's Test for Homogeneity of kontantp Variance
ANOVA of Squared Deviations from Group Means

Source | DF Sum of Squares Mean Square F Value| Pr=F
kvalitetgr | 2 1.017E12 5.086E11 1.06 03527
Error B6 3A71E1S 4.804E11

Nu kan vi aflese selve A NOVA-testresultatet nedenfor. Som du kan se, er p-verdien under
0,0001, hvilket er langt under vores signifikansniveau pa a=0,05, sa derfor konkluderer vi, at
der er signifikant forskel pa prisen af boliger i de forskellige grupper:

Source DF Sum of Squares Mean Square F Value Pr>F
Model 2 193245950 42 SBE2450°01 2563 <.0001
Error BB 24885130 .56 377047 .43

Corrected Total | 63 441011099

Det naeste spergsmaél, som man sé kan stille, er, hvordan boligprisen adskiller sig mellem de tre
forskellige grupper af kvalitetgr. Her kan vi i forste omgang se pa vores Box and whiskers-plot
nedenfor:

Distribution of kontantp
5000 F 2563

Prob = F <0001
4000 o
=3 [s]
=
& 3000 ° <
=
o
o
2000 o
<
1000 .
1 2 3

kvalitetgr

Plottet viser fordelingen af kontantprisen pa de tre forskellige grupper af kvalitetgr. Denne
type plot er god til at f& et overblik over dataene, da den ogsa giver overblik over spredningen
af data pa de enkelte grupper. Stregen igennem boksene er medianen og ikke gennemsnittet,
men det giver stadig en god fornemmelse af, hvordan de forskellige grupper af huspriser ligger
i forhold til hinanden.

Osas



STATISTIK MED SAS®

Man kan fortolke plottet som, at det serligt er huse i kvalitetgr 3, der adskiller sig fra de
to andre grupper ved at vere markant dyrere, hvorimod det ikke er helt tydeligt at se, om
forskellen mellem gruppe 1 og 2 er signifikant.

Hvis man vil have helt klare bud pa, hvilke grupper der er signifikant forskellige i forhold til
gennemsnitsprisen, kan man lave en post-hoc-test ved at gé tilbage og tilfeje dette til testen. Det
gores fx ved at trykke pa Modify Task i bjelken over outputtet og derefter vaelge Bonferroni
under menuen Comparisons, som det vises i de to nedenstédende billeder:

One-YWay ANOYE -

ﬂ Input D ata _,l Code J Log ] Pesults

'ES Refresh EJ Madify Task | Export = Send To = Create - Properties

Data Means > Comparizon
Testz
teans
Comparizon The main effect iz; kvalitetar.
Breakdown
Plats tethods to use i
H.ESUItS Banferoni | kest Confidence level 95% L
;Irt;T:uSerties [ Tukey's studentized range test [HSD)

—

Tryk derefter Run igen og bare sig Yes til dialogboksen, der kommer op og sperger, om det nye
output skal erstatte det gamle.

Outputtet fremkommer nuigen, og denne gang med Bonferronis simultane konfidensintervaller
nederst. Som du kan se, har SAS angivet, hvilke grupper der er signifikant forskellige fra
hinanden mht. kontantp. Konklusionen er, at gruppe 3 er signifikant dyrere end bade gruppe
1 og 2, men at gruppe 1 og 2 ikke er signifikant forskellige fra hinanden:

Comparisons significant at the 0.05 level
are indicated by ==,

Difference
kvalitetgr Between| Simultaneous 95% Confidence
Comparison Means Limits

3-2 1073.2 B12.0 1534.4 =
3-1 1231.5 782.8 16801 =
2-3 -1073.2 -1534.4 H12.0 =
2-1 158.3 -273.48 530.0
1-3 -1231.5 -1680.1 7§28 ™
1-2 -158.3 -580.0 2735

Altialthar vifundet ud af to ting: 1) At boliger med en hej herlighedsvardi er signifikant dyrere
end evrige boliger, hvilket jo ikke er sa overraskende. 2) At boliger med /av herlighedsverdi ikke
er signifikant billigere end boliger med en gennemsnitlig herlighedsverdi, hvilket umiddelbart
er lidt overraskende. Man skal dog vare forsigtig med at konkludere for meget ud fra dette,
for man kunne sagtens forestille sig, at boliger med beliggenheder med /lav herlighedsvaerdi
til gengeld har andre fordele, fx storre bolig- og grundareal, hvilket jo s igen bringer deres
boligpriser op. Om denne forklaring holder, kan du jo fx prove at teste med endnu en One-Way
ANOVA-test — nu ved du jo, hvordan man ger i SAS. (hint: gentag One-Way 4 NOVA-testen,
men brug i stedet variablen boligst som den afhengige variabel).
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3.1.5. Test flere gennemsnit pa to faktorer " Two-Factor’ ANOVA)

( Emnet for dette underafsnit er typisk ikke pensum pa indledende statistikkurser, men er alligevel
ret anvendeligt i praksis. Det kan dog sagtens springes over, hvis du har fdet nok af ANOVA for
nu. Sd kan du evt. fortsewtte med afsnit 3.2 pd side 50).

Hyvis du lavede den lille udfordring i slutningen af sidste afsnit, sa er du nok kommet frem til,
at med en almindelig One-Way ANOVA-test er der ikke signifikant forskel pa boligsterrelserne
mellem de forskellige kvalitetsgrupper af boliger. Men méske er sammenha@ngen mellem
boligsterrelsen og kvalitetsgruppen forskellig mellem nord og syd. 1 3.1.2 fandt vi jo ud af,
at huse nord for Kebenhavn er signifikant dyrere end huse syd for Kebenhavn — men maske
skyldes det jo bare, at de er storre. Alt dette kan vi opsummere i én test, som samtidig vil veere
bedre til at spotte, om der reelt er forskel i boligsterrelsen mellem de tre kvalitetsgrupper, nar
vi samtidig tager hojde for, om huset ligger nord eller syd for Kebenhavn.

I SAS skal vi nu have fat i en Linear Model, og den analyse vaelges via Analyze > ANOVA >
Linear Models...:

fnalyze | Export ~ SendTo -
| anova P eTest..
Reqgression P i One-Way ANOVA, .,
Multivariate P | Monparametric One-Way ANOVA...
Surwival &nalysis 2 ||E Linear Madels, .,
Capability p | E5 Mixed Models. ..

Her velges boligst som den afhaengige variabel, og kvalitetgr samt omr_ny velges som
klassifikationsvariable:

Linear Models for Local: WORK.QUERY FOR_BOLIGDATA

Data Data
Model
hodel Options
Advanced Options Data zource:  LocalwWORK QUERY_FOR_BOLIGDATA
Paost Hoo Tests Task filker: Mare
Least Squares
Arithretic
PI':'tS_ _ Wariables bo assigr: T azk roles:
?ir;s:tmns Mame i Dependent vaniable [Limit: 1]
Properties = - @ i )
@ geograf i Quantitative wanables
@ Kantantp 45 Classification variables
i@ baligst
=3 anon et [_\] =
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Under Model i menuen til venstre valges bade kvalitetgr og omr_ny, som trekkes over som
Main Effects. Bagefter markeres de begge, og der trykkes pa Cross. Derved oprettes en
sakaldt interaktion mellem de to variable, hvilket vil gere vores model fleksibel til at spotte,
hvis variablen “kvalitetsgr” ikke har samme effekt pa boligsterrelsen hhv. nord og syd for
Kebenhavn:

Data Model
Madel
tdodel Optiohs
Advanced Optiores Clazs and quantitative wvariables: Effects:
Pu:-sth:Sct Tseqzt:[BS 4 Lvalitetgr kwalitetgr
orr_riy
. - omi_
Aithrnetic: & om_ny cvealitetgromn_ry
Plrts

Under Model Options fraveelges Type 111 under Sum of Squares to show:

Data Model Options
Madel
Model Options
Advanced Options | Hypothesis tests Show parameter estimates
Post Hoo Tests : -
Least Squares A Shesy o Essertelzd e ket [] Confidence limits for parameter estimates
Aiithmetic Sum of squares to show
F'Iots. . Tigel
Fredictions
Titles L Typell
Properties I Typel
[ Type v

Under Plots har man flere muligheder for at fa et virkelig godt overblik over residualerne fra
testen, fx om de nu ogsa er helt uathengige pa tvers af alle grupper. I praksis er det ret vigtigt,
men her ngjes vi med at veelge et Interaction plot:

Data

Model

Model Options

Advanced Options

Fost Hoc Tests
Least Squares

Plots

Show plotg for linear models analpsis

(3 &)l appropriate plots for the curent data selection

Arithretic (%) Customn list of plots
Flots
Fredictions Custom plats:
Titles . [ Diagnostic plots
Froperties [] Residuals plot
"

Nu er vi klar til at trykke Run, hvorefter outputtet fremkommer. Forst i outputtet bliver det
opsummeret, hvilke levels de to kategorivariable har, hhv. kvalitetsgruppe 1, 2 og 3, inden for
hhv. omrade Nord eller Syd:

Class Level Information

Class Levels Values
kvalitetgr 3123
omr_ny 2 Mord Syd
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Derunder kan vi se, at modellen samlet set er signifikant med en p-verdi pa 0,0194, som ligger
under vores signifikansniveau a=0,05. Dvs. der er altsa signifikant forskel pa boligsterrelsen
mellem de tre kvalitetsgrupper og nord vs. syd, nar det ses samlet:

Source DF | Sum of Squares| Mean Square F Value Pr=F
Model 5 J23658.5219 G473.7044 293 0.0194
Error B3 139252 6375 2210.9942

Corrected Total  E8 171661.1554

R-Square Coeff Var Root MSE boligst Mean
0188561 2857803 47 02121 164 5362

Source DF Type | SS|Mean Square F Value Pr>F
kvalitetgr 2788115340 3940.57670 1.78 0.1768
omr_ny 1 16009.55816 1600955516 7.24 00031
kvalitetgromr_ny 2 8477831038  4235.90315 1.92 0.15585

Hvorvidt den overordnede signifikans af testen kommer fra en signifikant forskel mellem nord
og syd, eller om det skyldes forskel mellem de tre kvalitetsgrupper, kan vi se i den nederste
tabel ovenfor. Deraf fremgar det, at:

Forskellen 1 boligsterrelse mellem nord og syd er signifikant (p=0,0091, som er langt under
a=0,05).

Forskellen i boligsterrelse mellem kvalitetsgrupperne er ikke signifikant (p=0,1766).

Interaktionen mellem omrade og kvalitetsgruppe er ikke signifikant (p=0,1555), hvilket kan
fortolkes som, at der ikke er forskel pa boligsterrelserne af de forskellige kvalitetsgruppers
huse mellem hhv. nord og syd.

Vi kan altsa stadig ikke sandsynliggere, at der skulle vare forskel pa boligarealet af boliger i
de tre forskellige kvalitetsgrupper.

Hyvis vi ser pa interaktionsplottet nedenfor, kan vi pa den bla linje se, at der nord for Kebenhavn
er en tendens til, at boliger i kvalitetsgruppe 2 er mindre end de ovrige. Det er pa grund
af interaktionsvariablen kvalitetgr * omr_ny, at de to linjer nedenfor ikke er parallelle. Det,
plottet viser os, er lidt interessant, men vi husker pa, at forskellen i boligsterrelserne fordelt
pa kvalitetsgrupperne ikke er statistisk signifikant, jf. vores p-verdier for kvalitetsgr ovenfor:

Interaction Plot for boligst

300
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haligst
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kvalitetgr

omi_ny —e— Mord —e— Syd

Nu har du en ret grundig viden om ANOVA 1 SAS og er klar til ga til naste afsnit om andele.
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3.2. Test af andele (proportions) og antals-tabeller (Chi-i-anden-tests)

Hvis data er af den nominelle type (grupper), kan man ikke beregne gennemsnit. Derfor
beregner man tit andele/procenter i stedet. Det kraver nogle andre teknikker, baseret pa at
telle, hvor mange der er i hver gruppe. Test pa én andel introduceres i underafsnit 3.2.1 og test
pa forskellen mellem to andele i 3.2.2.

Hvis man gerne vil se, hvordan to nominelle variable er relaterede, laver man en antals-tabel (pa
engelsk Cross tabulation | Contingency table) pa kombinationer af de to variable. Derefter kan man
teste, om de to variable er uafhangige af hinanden. Denne teknik med at teste pa antals-tabeller
kalder man Chi-i-anden-tests (udtales Ki-i-anden). Et meget anvendt eksempel pa en Chi-i-anden-
test er en sikaldt uafthengighedstest, som vi prever at lave i underafsnit 3.2.3.

3.2.1. Test af en andel (= procent mellem 0% og 100% = tal mellem 0 og 1)

Et eksempel til test pa én andel er, at vi fx kan prove at teste, om andelen af boliger nord for
Kebenhavn i vores datasat er 50% (eller 0,5 udtrykt som et tal mellem 0 og 1). Det testes i
SAS ved forst at abne vores dataset Query for boligdata og derefter velge Describe > One-Way
Frequencies...:

bid Irput Data J_“,l Code | [Z] Log| % Results

<1 Filter and Sort g Query Builder | Data ~ | Describe + | Graph ~ Analyze - | Export = Send To - E
) nr |é_u,\ geograli k; List Data... grundst iz

1 1 Brandby o 635

2— 2 BrandbyStrand % Summary Statistics Wizard. .. Ea0

3 3 Espergzerde Z  Sumrary Skatistics. 1815

4 4 Espergzerde X 885

— S Tables Wizard. ..

h 5 Ezpergaerde I:‘ HLOITELR eI CALEETS B27

6 £ Espergeernde |:| Summary Tables. .. 702

Ex 7 Espergerde £ List Report Wizard.., B34

a8 8 Espergeerde ) 951

q 9 Espergeerde [“j Characterize Data... 1920

10 10 Greve H]h, Distribution Analysis. .. 32241

11 11 Greve One-Wa p 76

B | v Frequencies, .,

12 12 Greve |. - 756

= 19 Browe £ Table Analysis... rR

Variablen omr_ny trekkes over som analysevariabel:

One-Way Frequencies for Local: WORK.QUERY FOR BOLIGDATA

Data
Statistics
Pliats
Results Data source:  LocalWwORK.QUERY_FOR_BOLIGDATA
Titles Task filter: Maone
Froperties
Yariables bo assign: Taszk roles:
Mame H Analysis variables
I . i omi_ny
S — 4 Frequency count [Lirit: 1)
.{.;3’:: Elm.g“h, HE Group analysis by

Osas



STATISTIK MED SAS®
Side 47

Derefter skal man specificere, at vores hypotese er, at andelen af boliger i nord er 50%. Det
gores under menuen Statistics, hvor der allerede star 0,5 som standard 7est proportion og 95%
som Confidence level. Begge dele er fint. Der sattes ogsa flueben ved Exact p-values:

Dat§ . Statistics

Statistics

Plots - — :
Results Frequency table options Binamial proportions
Titles Inelude: [] Asymptatic test
Properties 7 Frequencies and percentages

= with cumulatives

~ Frequencies and cumulative

" (emeEs Test propartion: 05

() Frequencies and percentages
- Confidence level: 953 7
() Frequencies anly

Tryk nu Run, og outputtet nedenfor fremkommer. Deraf fremgér det, at i vores datasat er
56,5% af boligerne nord for Kebenhavn:

Cumulative Cumulative
omr_ny | Frequency Percent Frequency Percent
Nord 39 &B.A2 39 56.52
Syd 30 4345 B3 100.00

Det fremgar ogsa, at p-verdien for en tosidet test pa andelen 0,5 er 0,3356, hvilket er langt
over vores signifikansniveau a=0,05. Derfor kan vi ikke afvise, at der generelt er lige mange
huse til salg nord og syd for Kebenhavn (husk, at vi antogi 1.3, at dette datasat er et tilfeeldigt
udpluk af huse, der er til salg nord og syd for Kebenhavn):

Exact Test
Onesided Pr== P 01573
Twosided =2 * Onesided  0.3356

Om en test er en- eller tosidet kommer an pa, om vi pa forhand har belaeg for at antage, at det
teoretisk set kun kan falde til den ene side. Det har vi ikke her, sa derfor anvendes tosidet test.
SAS beregner dog begge p-vardier, som det ses ovenfor.

3.2.2. Test af forskellen mellem to uafhangige andele

Ofte kan det vare interessant at se, om to andele er signifikant forskellige fra hinanden. Vi
kunne ogséd godt fa en idé om, at der maske er flere boliger med hej herlighedsverdi nord for
Kebenhavn i forhold til syd, malt som andelen af boliger, der har verdien / i dummyvariablen
dummy_hojkvalitet 1 nord vs. syd. Det kan vi selvfolgeligt ogsa teste i SAS baseret pa vores
stikprove, sa vi kan fa nogle facts i stedet for geetteri.
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I SAS laves en datatabelanalyse. Det gores ved forst at abne vores analysedatasat Query for
boligdata og derefter vaelge Describe > Table Analysis.. ..

QUERY_FOR_BOLIGDATA -

1 Filter and Sort B35 Query Builder | Data - |Describe -| Graph = Analyze - | Export ~ Se
izl nr s geografi iz |E| ListData... an

186

L |:! randby T Summary Statistics Wizard, ..

2 2 BrandbyStrand

3 3 Espergeerde % Summary Statistics. .,
4 E d

d FpegesTe [E]  summary Tables Wizard...

] b Espergeerde

G 6 Espergesrde [£] summary Tables...

? 7 Espergeerde 0 List Report Wizard, ..

] 8 Espergeerde o )

9 9 Espergeerde [ Charactsrize Data...

10 10 Greve Ul Distribution Analysis...

11 11 Greve ﬂ Cne-Yay Frequencies...

12 12 Greve ;

13 13 Greve |ﬁ Table Analysis. .

Her vealger vi variablene omr_ny og dummy_hajkvalitet som Table variables:

Data Data

Tables

Cell Statistics

Table Statistics Data zowrce:  LocalwORK.QUERY _FOR_BOLIGDATA
Azzociation Taszk filter: Mone
Agreement
Ordered Differences
Trend TE_St _ Yariables to assign: Tazk roles:

HESE;t:-Srnputatan Optians M ame i@ Frequency u:qunt [Lirnit: 1]
Cell Stat Results @i ; g ?'T;I‘p E'”?'"fl's by
Table Stat Results £ gengrafi 2 ;m‘:a::: =

i it kontant £ omr_|
;Irﬂisnrﬁne F% hz::njr ’ I@ durnmy_hajkvltet

Under Tables ude til venstre trekkes forst omr_ny over som kolonnevariabel og derefter
dummy_hojkvalitet over som rekkevariabel:

Data Tables

Cell Statistics
Tahle Statistics Y ariables permitted in table: Presigw:
Agzociation
Agreement
Ordered Differences
Trend Test
Caomputation Options
Results
Cell Stat Results
Table Stat Results
Titles
Properties

Ofmr_Hy

durnrmy_haik.valitet

(Hvis du bruger en tidligere version af SAS end version 5.1, ser det lidt anderledes ud.)
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Derefter vaelges Cell Statistics ude til venstre, og Expected cell frequency tilvalges. Det er
nemlig en forudsetning for denne testtype, at alle celler 1 tabellen har en forventet verdi pa
minimum 5 observationer:

Cell Statistics

Axailable statistics

A zzociation [ Curnulative column percentages
Agresment [] Row percentages
Ordered Differences Bl FEEeEEs
Trend Test % )
Computation Options [V] Cel Frequencies
Results [] Cell percentages
Cell Stat Results [ Mizsing value frequencies
Tit Table Stat Resuits [] Cell contribution to Pearson chi-square
ithes o
Properties [] Cell frequency deviation from expected

E=pected cell frequency

[ Include percentages in the data sst

Under Association velges Chi-square tests (udtales [Ki]):

Data Table Statistics > Association

Tables

Cell Statiztics o

Table Statistics Testz of azzociation
Agzociation
Agreement EEhi-square tests
Ordered Differerces [“lillnciuding Pearsan, likelihood ratio and MantelH aenszel |
Trend Test ichi-square testz and Fizher's exact test for 262 tables]

Der er selvfolgeligt mange andre valgmuligheder, men dette er nok for vores analyse. Derfor
kan du nu trykke Run, hvorefter outputtet fremkommer. Qverst er en tabel, der opsummerer,
hvordan dataene er fordelt. Fx kan vi se, at der i nord er 11 boliger 1 vores stikpreove med hoj
herlighedsvardi. De 11 udger ca. 28% af alle 39 boliger i nord. Tilsvarende kan vi se, at der er
9 boliger med hej herlighedsverdi i syd, hvilket udger 30%.

Table of dummy_hajkvalitet by omr_ny
omr_ny
Nord| Syd Total
dummy_hsjkvalitet

0 Frequency 28 21 49

Expected 27 .E96 21.304

Col Pct 7179 70.00
1 Frequency 11 9 Z0

Expected 11.304 86257

Col Pct 2821 30.00

Total Frequency 39 o BR
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Lengere nede i outputtet far vi vores p-vaerdi. Pa dette punkt er SAS rigeligt generos — vi
far mange forskellige tests for det samme. Vi ser bare pa den overste p-verdi (Prob) for
Chi-Square-testen. Den er pa 0,8706, dvs. langt over vores signifikansniveau pa a=0,05:

Statistic D
Chi-Square

Likelihood Ratio Chi-Square
Continuity Adj. Chi-Square
Mantel-Haenszel Chi-Square

Value Prob
00265 08705
00265 08707
0.0000 1.0000
00262 08715

—_ - - T

Phi Coefficient 0.0196
Contingency Coefficient 0.0196
Cramer's V 0.0196

Konklusionen er derfor, at der altsd intet statistisk beleg er for at konkludere, at andelen af
boliger med hej herlighedsverdi er forskellig mellem nord og syd (forudsat, at vores stikpreve
er reprasentativ for alle boliger nord og syd for Kebenhavn).

3.2.3. Test for uafhengighed (Chi-i-anden-test)

I forrige eksempel testede vi to andele via Table Analysis (underafsnit 3.2.2). P4 samme made
kan storre antals-tabeller ogsa testes. Vi kan fx teste, om der er en sammenhang mellem,
hvilken kontantprisgruppe en bolig ligger 1 pa den ene side, og hvilken kvalitetsgruppe den
ligger i pad den anden side. Her vil man nok intuitivt forvente, at der er en sammenhang:
Boliger med hej herlighedsverdi vil nok ogsa vere i den dyre ende af skalaen — og omvendt
for boliger med /av herlighedsvaerdi. En sddan test hedder en uafhengighedstest, fordi vores
HO er, at der er uafthangighed mellem de to variable. Hvis vi far en signifikant p-verdi i testen,
sa forkaster vi HO og konkluderer, at der ikke er uath®ngighed, altsd at de to variable er
indbyrdes forbundne pa en eller anden méde.

Lad os prove at teste vores uafhangighedstest mellem kvalitetgr og kontantp_gr i SAS?.
P4 samme méde som i forrige underafsnit abnes datasattet Query for boligdata, og der velges

Describe > Tuble Analysis... Her veelges variablene kvalitetgr og kontantp_gr som tabelvariable
som nedenfor:

&= Table Analysis1 for Local; WORK.QUERY FOR_BOLIGDATA

Data Data
Tables

Cell Statistics

Table Statistics
Agzociation
Agreement
Ordered Differences
Trend Test

Data zource:  LocalwORK . QUERY_FOR_BOLIGDATA
Task filter: More

Wariables to azsign: Tazk roles:

Computation Options

Results M ame | Frequency cqunt [Lirnit: 1]
Cell Stat Results i | 4 Group an~_fl|5JSIS b
Table Stat Results @Egugrafi 4 Table variables
Titles i) kontantp A ku:unt.antp_gr
Properties iz boliost () kwalitetgr

3. Homogenitetstests laves pa nejagtig samme made i SAS — det er kun en teoretisk forskel ift.
uafhaengighedstesten.
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Herefter vaelges Tubles ude til venstre, og tabellen bygges op ved at treekke kontantp_gr over
som kolonnevariabel, og kvalitetgr over som raeekkevariabel:

Tables

Cell Statistics
T able Statistics Wariables permitted in table: Presvig:

Agzzociation
Agreement
Ordered Differences
Trend Test
Computation Options
Resultz
Cell Stat Results
Table Stat Results
Titles
Froperties

kontantp_gr

kealitetar

Herefter foretages de samme tilfgjelser til indstillingerne som dem, der er billeder af i forrige
underafsnit 3.2.2. (Cell Statistics > Expected cell frequency og Association > Chi-square-test).
Tryk derefter Run, og nedenstaende output kommer frem:

Table of kvalitetgr by kontantp_gr
kontantp_gr
hsj lav| middel Total
kvalitetgr
1| Frequency 2 10 14 26
Expected 7.913 45217 13665
Col Pct 952 8333 B89

2 Frequency 3 2 18 23
Expected 7 4 12
Col Pct 1429 1667 50.00

3 Frequency 16 1] 4 20

Expected G6.037 34733 10435
Col Pet 7619 0.00 11.11

Total Frequency| 21 12 3B B9

Hvis vi ser pad Expected cell frequencies i tabellens rekker med Expected..., sa kan vi se, at
disse tal er under 5 for alle boligerne i den lave kontantprisgruppe. Da det er en forudsatning,
at alle Expected-verdierne er over 5, kan vi ikke stole pa testen nedenfor. Bemerk ogsa, at
SAS advarer os om det under tabellen med p-verdien fra Chi-square-testen:

Statistic DF Value Prob
Chi-Square 4 4094558 <0001
Likelihood Ratio Chi-Square 4 412513 =000
Mantel-Haenszel Chi-Square 1 143318 0.0002
Phi Coefficient 0.7703
Contingency Coefficient 0.6103
Cramer's V 0.5447

WARNING: 33% of the cells have expected counts less
than 5. Chi-Square may not be a valid test.
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Lesningen er at @ndre pa kategorierne — der er abenbart for fa huse i boligkategorien af huse
under 1,5 mio. kr. Derfor vil vi @ndre pa kodningen af kontantprisgruppevariablen kontantp_
gr til kun at have to kategorier: /av for huse under 2 mio. og hoj for huse over 2 mio. Denne
@ndring laves ved at ga tilbage til vores Query i Process Flow-diagrammet og @ndre kodningen
af variablen kontantp_gr. Forst hejreklikkes pa Query-ikonet i Process Flow-diagrammet, og
vi velger Modify Query builder:

=] ©pen 3
[ Run Query Builder

I]ua| [x]  Modify Query Builder
Build Run Branch From Cuery Builder

Derefter dobbeltklikker man pa variablen kontantpr_gr og velger Edit... 1 den naste
dialogboks. Nu skal vi have @ndret vores kategorier til at veere som pa billedet nedenfor, dvs.
lav hvis mindre eller lig med 2000 og &oj hvis sterre eller lig med 2001 (hvis du ikke kan huske,
hvordan man gor, kan du se det i afsnit 2.3.3 pé side 30):

les || Select Data Fi\[g[Dr" P |

Edit Computed Column
Colurnn Mane

12 nr

& - Colurmn Name:  kontantp_gr 1 af2 Specify a replacement
{2l kontantp Label

@ boligst Fieplacement

128 grundst 5

% iemlse Format: SCHARTO. [ Crange.. | S —

) kvalitet Summary: Hone Length (in bytes) <=2000 :lav:

2D kvalitetar X »=200 hai
Eop—_— Erpression; CASE

. kontantp_gr “WHEM t1 kontantp <= 2000 THEN 'lav'

WHEM t1.kontantp >= 2001 THEN ‘haj'
Yo dummy_hajkeval MD

fiser [H kvrpris

Edit...
<

Identifier Kontanoris oniooering

Tryk herefter Finish, OK og Run. Nu bliver du spurgt, om du vil overskrive det tidligere
resultat. Da alle vores forgadende analyser er baseret pa det tidligere dataset, er det en god idé
at svare No til det:

SAS Enterprise Guide @

9P Do yvou want ko replace the resulks from the previous run?

Choosing "Mo” will save the changes to a new task, named "Query Builder1”,

[ es ] I Mo J [ Caniel
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Derved vil vores redigerede Query resultere i et nyt datasat. Det nye dataset fremkommer
ogséa som et nyt ikon efter vores nye Query nederst i Process Flow-diagrammet:

ST |

Pl
Cuery Queny
Builder1

Baseret pa det nye datas@t prover vi at gentage uafh@ngighedstesten fra for, men denne
gang med den nye udgave af variablen kontantp_gr. Fremgangsmaden er nejagtig som for.
Outputtet bliver som nedenfor:

Table of kvalitetgr by kontantp_gr
kontantp_gr
hsj lav| Total

kvalitetgr
1 Frequency B 18 26
Expected 13585 12.435
Col Pct | 2222 54155
2 Frequency = 15 23
Expected 12 11
Col Pct | 2222 4545
3 Frequency 20 o 20
Expected 10435 95652
Col Pct 5556  0.00
Total Frequency & 33 B9

Statistics for Table of kvalitetgr by kontantp _gr

Statistic DF| Value Prob
Chi-Square 2 258951 <0001
Likelihood Ratio Chi-Square | 2| 33.7071 <.0001
Mantel-Haenszel Chi-Square = 1 198311 <.0001

Phi Coefficient 06126
Contingency Coefficient 0.5224
Cramer's V 06126

Vi kan se, at foruds@tningen om, at Expected skal vare over 5 i alle celler af tabellen, nu er
opfyldt. Ser vi pa Chi-Square-testen, sé er p-verdien under 0,0001, hvilket er langt under vores
signifikansniveau :=0,05. Dvs. vi forkaster vores H, om uafhengighed og konkluderer, at der
er afhengighed mellem prisgruppe og boligens kvalitetsgruppe. Dette matcher fint, hvad vi
ville forvente at se.

Nu har vi godt styr pa andels-tests og tests pa datatabeller og er klar til at g videre til et nyt
emne.
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3.3. Regressionsanalyse

En anden ofte brugt gruppe af teknikker tester sammenhangen mellem en afhangig
intervalvariabel og en eller flere uafth@ngige intervalvariable. Ideen her er, at maske kan
én variabel forklares af en eller flere andre variable. Fx giver det god mening at antage, at
huspriser til en vis grad kan forklares af boligsterrelsen. Det illustrerer vi med scatter plot
og korrelationskoefficient i underafsnit 3.3.1, og i 3.3.2 laver vi en simpel line®r regression
mellem disse to variable.

Det giver dog ogsa god mening at antage, at grundstorrelsen nok ogsa spiller ind pa boligprisen
sammen med antal verelser og herlighedsvardien af boligen ligesd. Hvis man vil lave en
udvidet regressionsmodel baseret pa disse antagelser, sd er det en multipel regressionsanalyse,
man skal lave, og det prever vi i underafsnit 3.3.3. Regressionsanalyser arbejder primeert med
intervaldata, men kan ogsa handtere nominel data, og det ser vi et eksempel pé i underafsnit
3.3.4, hvor vi ogsa prever at tilfeje andre “eksotiske” variable til vores model (se evt. afsnit
2.2.1 pa side 16 for en repetition af datatyper). I 3.3.5 prover vi at lave en logistisk regression,
som er noget lidt andet, hvor den atha@ngige variabel er numerisk med to kategorier (en enten/
eller-variabel).

3.3.1. Scatter plot og test af korrelation mellem to intervalvariable

Hvis vi har to intervalvariable, kan de plottes i en graf pa to akser — ngjagtig som du ville
markere x- og y-koordinater pa et ternet ark papir. Her kalder vi det bare et scatter plot, men det
er altsd det samme princip. Idéen med at lave sddan et plot er at se, om der er en sammenhang
mellem de to variable. Her vil vi preve at lave et scatter plot med boligsterrelsesvariablen
boligst pa X-aksen og boligprisvariablen kontantp pa Y-aksen.

I SAS gores det ved forst at abne vores dataset Query for boligdata og derefter veelge Graph >
Scatter Plot..., som det er gjort nedenfor:

QUERY_FOR_BOLIGDATA -

. Fiter and Sort Bs Query Buider | Data ~ Describe - | Graph - | Analyze ~ | Export ~ Send To - E
) nr % geografi @ kontar [l Bar Chart wWizard. .. B

1 11 Brandby [l Bar Chart...

2 2 BrandbyStrand

3 3 Espergzerds % Pie Chart Wizard...

4 4 Espergeerde 3 Pig Chart...

h 5 Espergeerde

3 fi Espergeerde |~ Line Plot wizard...

7 7 Espergeerde [## Line Plat...

] 8 Espergserde -

g9 9 Espergesrds |,_ Scatter Plok.., |

Derefter specificerer vi forst, at det er et 2-dimensionalt Scatter Plot, vi vil lave:

‘= Scatter, Plot for Local: WORK.QUERY _FOR

Siatter Plat Scatter Plot
Data

Appearance
Flotz
Interpolations
Asez
General
Harizantal Sz
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Under Data ude til venstre flyttes variablen boligst over pa Horizontal-aksen og variablen
kontantp over pa Vertical-aksen:

Scatter Plot Data
Data
Appearance
Platz Data gource:  Local™w0ORK.QOUERY_FOR_BOLIGDATA
|nterpolations Task filker: Hone
Anes
General
HU'iZDhtal Auis Columns to assign: Task roles:
::l*;'?m _— Mams & Hotzontal Lini 1)
Minar Ticks 2 =) %]) ” I
Reference Lines £ geografi = G;[ 'ﬂantp
Velical dis @ konterip 3] Vertical(ight) (Lini 1]
A @ bualigst {\_5’ Group charts b
M ajor Ticks i arundst F ¥

De resterende valgmuligheder er ligegyldige her — vi er klar til at trykke Run, hvorefter vores
Scatter Plot fremkommer:

kontantp
a000

4000

3000

2000

1000

a0 100 150 200 240 300 340 400
baoligst

Scatter-plottet viser, at dataene ligger noget spredt, men der er dog en tendens til, at huspriserne
stiger, nar boligsterrelsen stiger. Hvorvidt der er en line@r sammenhang, kan vi undersoge
ved at teste korrelationen mellem de to variable.

Korrelationer testes 1 SAS ved igen at abne vores datasaet Query for boligdata, og velge Analyze
> Multivariate > Correlations, som det er gjort nedenfor:

QUERY_FOR_BOLIGDATA =

Sl Filter and Sort By Query Builder | Data ~ Describe ~ Graph - | Analyze =|| Export = Send To -
iz nr . geografi @ kontantp @ ANCYA 4 @ vaerelse @ kvalitet
1 1§ Brandby 395 Regression y 5 2
2 2 BrandbyStrand 1478 —
S Multiv ariate 3 i
3 3 Espergeerds 100 | || ~° Correlations. .
4 4 Ezpergesrde 2950 Survival finalysis b | # Canonical Carrelatian. .,
b 5 Espergesrde 1885 Capability y | Principal Components. .,
[ b Ezpergeerde 1835 | S S
7 7 Fermarnzsrda QROR Contral Charts L4 = BELDP ARSLYSES. ..
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Derefter traekkes variablene kontantp og boligst over som Analysis variables:

. Correlations for Local: WORK.QUERY FOR_BOLIGDATA

Data Data
Options
Results
Output Data Data source:  Local™wORK.QUERY_FOR_BOLIGDATA
Titles Task filker: MNone
Froperties
Wariables to azsign: Task roles:
Name i Analysiz variables
23 e
eografi _
%g d i Corelate with
21 kontantp .
) 45 Group analysis by
iz baligst S _—
@ undst & Frequency count [Limit; 1)
: g i Partial vaniables
@ vaerelse ) Relative weight (Limit: 1]

Vibehover ikke lave flere indstillinger og er derfor klar til at trykke Run, hvorefter nedenstaende
output fremkommer. Heraf fremgar det, at korrelationskoefficienten er 0,59408, hvilket skal
ses 1 forhold til, at 0 ville betyde ingen relation mellem de to variable, og 1 ville betyde en
perfekt linezer ssmmenhang mellem de to variable.

Korrelationskoefficienten er her sa hgj, at sandsynligheden for, at det bare er en tilfeeldighed
(p-verdien), er under 0,0001 dvs. langt under vores signifikansniveau pa «=0,05, s& vi
konkluderer, at de to variable er signifikant positivt korrelerede. Dvs. at hvis den ene variabel
fx stiger, sa stiger den anden sandsynligvis ogsa:

Pearson Correlation Coefficients, N = 69
Prob = |r| under HO: Rho=0

kontantp boligst
1.00000 0.59405
kontantp <. 0001
0.59405 1.00000
boligst =.0001

Dette matcher jo ret godt, hvad vi intuitivt ville forvente.

3.3.2. Simpel linezr regression (regression med én forklarende variabel)

I sidste underafsnit fandt vi en signifikant korrelation mellem boligsterrelsen og boligprisen.
Det er meget vigtigt at huske pa, at en hgj korrelation ikke nedvendigvis betyder, at &ndringer
i den ene variabel forer til @ndringer i den anden. Det er den nok hyppigste fejlantagelse i
anvendt statistik.

At en variabel leder til en anden kaldes kausalitet. Hvis du synes, kausalitet er et grimt ord, s&
bare tenk pa det engelske cause (at forarsage noget), sa giver det lidt mere mening.

Hvis vi vaelger at antage kausalitet mellem boligstorrelsen og kontantprisen, sa skal vi begrunde
det med en teoretisk sammenhang og ikke, at vores data er hejt korrelerede. I vores tilfelde vil
vi antage, at et storre boligareal medferer en hojere boligpris, selvom der ogsé kan vere mange
andre forklaringer, som ogsa har effekt her (fx at store huse méaske bygges i populere omréder,
er af hejere kvalitet og er mere velholdte).

Fordi vi antager kausalitet, sd giver det mening at lave en regressionsmodel, der undersoger,

hvor meget boligprisen stiger, nar boligstarrelsen stiger med fx 1 m%. Modellen er selvfolgelig
en grov forenkling af virkeligheden, men vi prever alligevel for eksemplets skyld i SAS.
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Start med at adbne datasattet Query for boligdata og velg Analyze > Regression > Linear
Regression..., som det er gjort nedenfor:

QUERY_FOR_BOLIGDATA +

1 Filter and Sort i Query Buider | Data = Describe ~ Graph - | Analyze «| Export = Send To -
iz nr A geografi @ kontanip @ ANOVA 4 @ vaerelse @ kalitet E
1 14 Brandby 335 | Regression * ||£ Linear Regression. .. |
2 2 BrandbyStrand 1478 Multivariate v |1z i -
3 3 Espergeerde 00 = Monlinear Regression...
4 4 Espergasrde 2350 Survival Analysis » ||ii  Logistic Regression ...
5 5 Espergeerds 1885 Capabilly y | Gereralized Linear Models. ..
c £ Fenarnsarda 1998 - -

Traek derefter kontantp over som Dependent variable og boligst over som Explanatory variable:

' Linear Regression for Local:BOLIGLIB.QUERY FOR_BOLIGDATA

Data
Model
Statiztics
Plots
Predictions
Titles
Properties

Data

Local:BOLIGLIB.QUERY_FOR_BOLIGDATA
More

D ata source:
Task filker:

‘Wanables to assign:

Task roles:

Mame | Dependent vanable [Lirnit: 1]
[ 3/ kontantp

{::‘» geografi @) Explanatory variables

i) kontantp

Der er mange flere indstillingsmuligheder, men standardindstillingerne er OK for os, sa vi er
klar til at trykke Run, hvorefter vores output kommer frem:

Analysis of Variance

Sum of Mean
Source DF| Squares| Square F Value Pr>F
Model 1 15603372 15603372  36.54 <.0001
Error B7 28605739 4269685

Corrected Total B3 44210111

Root MSE B53.42655 R-Square 0.3529
Dependent Mean | 2255313584 Adj R-Sq | 0.3433
Coeff Var 2897269
Parameter Estimates
Parameter| Standard
Variable DF Estimate Error|t Value Pr > [
Intercept 1 BS8E.E3739 271.15216 253 037
boligst 1 953396 157711 G.05 <.0001

Overst ovenfor ser vi en ANOVA-test for, om modellen overordnet set er signifikant.4 Det
er den med den lave p-vardi pa under 0,0001, som jo er meget under vores signifikansniveau
pa 0=0,05. Vi kan i den midterste tabel se, at boligsterrelsen kan forklare 35% af prisen pa
boliger (R2=0,3533). Den nederste tabel viser os, at i denne forenklede model for prisdannelsen
pa boliger resulterer én ekstra kvadratmeter i en prisstigning pa 9.500 kr. Denne effekt er
signifikant (p-verdien er igen under 0,0001).

4. Det virker méaske lidt merkeligt, at der bliver lavet en ANOVA-test i en regressionsanalyse,
men sddan tester man overordnet modellen.
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Nedenfor er et plot, som viser, hvordan SAS generaliserer fra vores stikprove til populationen.
Det gra skraverede omrade er et konfidensinterval for gennemsnitsprisen af boliger med
den givne boligsterrelse. Det noget bredere forudsigelsesinterval, som ligger inden for vores
prediction limits stiplede linjer, er det interval, hvori prisen pa en tilfeldig bolig med en given
boligsterrelse med 95% sikkerhed vil ligge (et gennemsnit kan altid estimeres mere pracist end
individuelle observationers verdier):

Fit Plot for kontantp

5000

4000

Chservations G49

o Parameters 2
*g 3000 Error DF 67
= MSE 426966
=]
o

R-Sguare 0.3528

Adj R-Square 0.3433
2000

1000

100 200 300

boligst
Fit O 95% Confidence Limits 95% Prediction Limits

Forudsatningerne for regressionsanalysen burde vi for evrigt have tjekket, for vi konkluderede
pa resultaterne ovenfor, men dem gemmer vi til neste afsnit — flere af forudsetningerne
har nemlig at gore med situationer, hvor man har mere end én forklarende variabel i sin
regressionsanalyse, og det har man nzsten altid i praksis. Regressionsanalyse med mere end én
forklarende variabel kaldes multipel regressionsanalyse, og det er emnet for naste underafsnit.

3.3.3. Multipel linezr regression (regression med flere forklarende variable)

Virkeligheden er ofte mere kompleks end som si, og regressionsmodeller med kun én
forklarende variabel kommer nasten altid til at overfortolke pé effekten af den uafthengige
variabel pa den athangige. I vores eksempel med boligprisens afth@ngighed af boligsterrelsen
kommer vi let til at overfortolke effekten af boligsterrelsen, fordi boligsterrelsen er korreleret
med bade grundsterrelsen og antal varelser. Det kan ses ved at lave en korrelationstabel
ligesom 1 underafsnit 3.3.1, men denne gang medtage de fem variable kontantp, boligst,
grundst, vaerelse og kvalitet som Analysis variables:

Tazk roles:

| Analysiz vanables
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Korrelationstabellen ser ud som nedenfor, hvor de mange lave p-vardier indikerer signifikante
korrelationer. Tabellen er symmetrisk, sa det er ligegyldigt, om vi afl@ser den everste venstre
eller den nederste hojre “trekant”. Ser vi pa forste reekke, kan vi se, at kontantp er signifikant
korreleret med alle de fire ovrige variable. Det indikerer, at alle de ovrige variable kan bruges
til at forklare variablen kontantp. Ser vi pa de naste rekker, kan vi se, at de tre variable boligst,
grundst og vaerelse ogsa er signifikant korrelerede med hinanden. Variablen kvalitet er derimod
ikke signifikant korreleret med de evrige tre variable.

Pearson Correlation Coefficients, N =69
Prob > |1 under HO: Rho=0
kontantp  boligst grundst vaerelse kvalitet
1.00000 059408 055371 0.48440 0.60851

kontantp 0001 <0001 =0001 <000
0.59408 1.00000 048060 067012 -0.04583
holigst <.0001 <0001  =«0001  0.7085
0E5571 0480680 1.00000 0.32398 -0.01850
grundst <0001 =.0001 0.00e6 08775
0.48440 DE7012 032395 1.00000 -0.01100
vaerelse <0001 <0001 00065 0.9285

060861 -0.04533 -0.01850 -0.01100 1.00000
kvalitet <0001 07035 08775 05285

Vi prover at lave en ny regressionsmodel, som denne gang formuleres som, at kontantprisen
afhenger af boligsterrelsen, grundstorrelsen, antal verelser og boligens herlighedsverdi. Vi
kan ogsa skrive det som, at kontantprisen er en funktion af de evrige variable:

kontantp = f(boligst, grundst, verelser, kvalitet)

I SAS ger vi, som vi gjorde i forrige underafsnit 3.3.2, men bare med flere forklarende/
uafhengige variable. Abn forst datasettet Query for boligdata og velg derefter Analyze >
Regression > Linear Regression... Vores Dependent variable er igen kontantp, og de fire ovrige
ovenfor nevnte variable er Explanatory variables:

T azk roles:

i@ Dependent variable [Limit: 1]

@ ki

i@ Explanatary variables

ontantp

I princippet kan vi trykke Run nu og fa vores output, men vi skal lige huske at tjekke vores
forudsetninger ogsa. Forudsatningerne for multipel regressionsanalyse er opsummeret
nedenfor:

a. Normalfordelte residualer: P4 samme made, som vi tjekkede kontantp med histogram og
QQ-plots tilbage i underafsnit 2.2.3, skal vi her have tjekket residualerne.

b. Ens varians af residualerne: Tjek dette via Statistics > Diagnostics > Heteroskedasticity
test samt et plot af standardized residuals vs. predicted values.

c. De forklarende variable mé godt vaere korellerede, men ikke for meget. Det males med
Variance inflation values, som skal vere under 5. Dem far man i SAS via Statistics >
Diagnostics > Variance inflation values.
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d. Residualerne skal vere uafhengige af de forklarende variable, og der mé ikke vere trends:
Tjek dette ved at se pa plots af residualerne i forhold til de enkelte forklarende variable 1
modellen. Der ma ikke vere menstre.

For at opsummere, hvad vi mangler at angive i SAS, mangler vi bare at sette flueben ved de
to valgmuligheder under Statistics-menuen og derefter at velge plots. Det forste gores ved at
vealge Statistics ude til venstre og derunder vaelge Heteroskedasticity test og Variance inflation
values, som det er vist nedenfor:

Data

Statistics
b odel
Plats Detailz on eztimates Diagnoztics
Predictions [ Standardized regression coefficients [ Callinearity analysis
Titles [ Sum of squares, Type 1 [ Collinearity analysiz without the intercept
Froperties [ Sum of squares, Type 2 [ Tolerance values for estimates
[ Comelation matrix of estimates Wariance inflation values
[] Covariance matris of estimates Heteroscedasticity test
[ Confidence limits for parameter estimates [ Asymptatic covariance matix

[ Durbinw!atson statistic

Plots veelges ved at valge Plots-menuen. Som standard far man rigeligt med plots, og vi vil
faktisk velge lidt feerre for overskuelighedens skyld. Vi valger derfor Residuals by predicted
values plot, Normal quantile plot of the residuals (QQ-plot) og Residual plots:

Data

Plots

Model
Statistics
F'Iots. : Shaw plots for regression analyzis
Predictions . )
Titles ) &l appropriate plots for the cument data selection
Properties (%) Custom list of plats

Custom plots:

[] Histograrn plat of the residuals A

L L ok

[ Studertized residuals by predicted values plot
[] Observed by Predicted values plat

[] Plat Cook's Dn statistic

[ Studentized residuals by leverage plot

Mormal quantile plot of the residuals

[[] Residual-Fit plat

[[] Box plat of the residuals

[[] Diagrostic plats

[] DFFITS plats

[[] DFBETAS plats

Residual plats v
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Nu er vi klar til at trykke Run, hvorefter vi far vores regressionsanalyse og forudsatningstjeks
output. Lad os se pa foruds@tningerne forst:

a. QQ-plottet af residualerne indikerer, at denne forudsatning faktisk ikke er opfyldt pga.
nogle enkelte ekstreme observationer. Da det er boligmarkedet, kan disse yderpunkter
karakteriseres som hhv. “handverkertilbud” i den ende, hvor prisen er lavere end
modellen forudsiger (husk, at vi ikke har en variabel med, der maler boligens stand),
og fx kvalitetsbyggeri ud over det sedvanlige i den evre ende (vores kvalitetsvariabel
maéler herlighedsvaerdien af husets beliggenhed, men ikke selve husets “liebhaververdi”).
Her gar vi dog videre, som om forudsetningen var opfyldt (hvis du anvender
logaritmen til boligprisvariablen kontantp, som vi omtalte i underafsnit 2.3.5, i stedet
for kontantp 1 regressionsmodellen, sa loser det faktisk problemet — prov evt. selv!):

Q-Q Plot of Residuals for kontantp

Residual

-500

Cuantile

b. Heteroskedasticity test er det, som i fagbeger kaldes White’s test, og det tester, om
residualerne har nogenlunde ens varians for de forskellige verdier af den afhangige
variabel kontantp. Udgangspunktet (HO) er, at der ikke er problemer. Outputtet fra testen
er nedenfor og konkluderer, at der ikke er problemer, eftersom p-verdien er pa 0,3120
som er hgjere end vores signifikansniveau pa o=0,05:

Test of First and Second
Moment Specification
DF | Chi-Square| Pr = ChiSq
14 16.02 0.3120

Vi kan ogsé se det grafisk pa plottet af de standardiserede residualer i forhold til de
boligpriser, vores model estimerer:
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Residual by Predicted for kentantp
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Her kunne det maske godt se ud, som om variansen @ndrer sig lidt i takt med, at Predicted
Value stiger. Det skyldes givetvis de enkelte meget heje residuals, som forvrider billedet
lidt. En lesning ville vere at bruge In(kontantp), og hvis du er flittig, kan du jo preve at
gore det (det fikser faktisk alle potentielle forudsaetningsproblemer). Her antager vi dog for
enkelhedens skyld, at denne forudsatning ogsa er opfyldt.

Variance inflation-verdierne er alle under 5, sa den forudsatning er OK (se dem i Parameter
Estimates-tabellen nedenfor).

. Uafthengige residualer tjekkes i graferne nedenfor. Der er lidt problemer i forhold til

kvalitet-variablen og maske ogsa i forhold til nogle af de andre, men i det store hele vurderes
det, at forudsatningen er tilstreekkeligt opfyldt:

Residual by Regressors for kontantp
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Vi er nu klar til at aflese regressionsresultatet. Nedenfor ses det i ANOVA-tabellen, at
modellen overordnet set er meget signifikant med en p-verdi pa under 0,0001, som er meget
under vores signifikansniveau a=0,05. Vi kan ogsa se, at vores nye model kan forklare 94%
af prisdannelsen pa boligerne i stikproven (R2-vardien). I nederste tabel kan vi se, at alle de
forklarende variable ogsa er meget signifikante, alle med en p-verdi tet pa nul:

Analysis of Variance
Sum of Mean

Source DF Squares Square| F Value Pr=F
Model 4 416498389 10412472 26029 =.0001
Error B4 2560222 40003
Corrected Total B3 44210111
Root MSE 20000866 R-Square 09421
Dependent Mean 225531884 Adj R-Sq 05335
Coeff Var 3.66531
Parameter Estimates
Parameter Standard Variance
Variable DF Estimate Error t Value Pr = [tf| Inflation
Intercept -086 BaR43 10945587 -5.10 =.0001 0
holigst 4 90613 0.702&80 B.93 <0001 211771

vaerelse g7 47838 26.80101 326 00018 1.81640

1
1

grundst 1 0.75071 005411 1387 <0001 1.30033
1

kvalitet 1 45245260 2152911 2102 <0001 1.00283

Parameterestimaterne ovenfor kan i forhold til effekten af boligsterrelsen pa boligprisen
afleeses som, at hvis boligsterrelsen stiger med 1 m?, mens alle de gvrige variable forbliver
konstante, sa stiger boligens pris med 4.900 kr. — hvilket jo kun er knap det halve af de 9.500
kr., vi fandt i den simple linezre regressionsanalyse i foregdende underafsnit 3.3.2. Resultatet
1 denne multiple regressionsanalyse er mere korrekt, og det viser bare vigtigheden af at huske
at fa alle relevante variable med.

De ovrige parameterestimater fortolkes som, at 1 m? gget grundareal resulterer i en forventet
prisstigning pa 750 kr., og at et ekstra verelse uden oget boligsterrelse resulterer i en forventet
prisstigning ca. 87.000 kr. En @ndring i boligens herlighedsverdi er associeret med en virkelig
stor prisstigning pa knap > mio. kr. for hvert forbedringstrin pa skalaen fra 1 til 5. S& hvis
man bor ved siden af en fabrik, der pludselig uventet lukkes og bliver lavet om til en smuk
naturpark, sa er det virkelig noget, der kan ses pa boligpriserne i omréadet!

Det er ret sjeldent, at man har sa hej en forklaringsgrad (R2), som vi har i dette eksempel.
Men vi vil alligevel prove, om vi kan forbedre modellen yderligere i n@ste underafsnit — og
samtidig introducere nogle andre nyttige regressionsteknikker.

3.3.4. Regression med mere avancerede variable

I dette underafsnit vil vi forsege at forbedre modellen fra den multiple regressionsanalyse i
forrige underafsnit 3.3.3. Vi vil prove at tilfeje tre nye typer variable til vores regressionsanalyse.
De tre forskellige variable er:

i. En nominel forklarende variabel: Vi vil tilfoje omradevariablen og se, om der er forskel pa
boligpriserne mellem nord og syd, nér alle de andre variable ogsa tages i betragtning.

ii. En kvadreret variabel, dvs. en variabel ganget med sig selv. Det giver mulighed for, at
en variabel kan have en enten aftagende eller stigende effekt. Vi vil prove at medtage
grundst*grundst (kan ogsa skrives som grundst®) for at undersoge, om prisen for en
yderligere kvadratmetergrundsterrelse fx aftager, efterhidnden som grundsterrelsen
kommer over et vist niveau. Det kan jo vare, at ens have kan blive sa stor, at gleden ved
den ekstra plads bliver trukket gevaldigt ned, nar graesplenen skal klippes en gang om
ugen i sommerhalvaret.
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iii. Interaktion mellem boligsterrelsen og grundsterrelsen inkluderes ogsa ved at gange dem
sammen: boligst*vaerelse. Det kan selvfolgeligt gores direkte i analysen i SAS. Idéen med
at inkludere en interaktion er, at det giver mulighed for, at veerdien af et ekstra varelse kan
afhange af boligstorrelsen. Méaske er vardien af et ekstra varelse fx storst i sma boliger,
og det kan vi sé teste med en interaktionsvariabel.

Vier nu klar til at lave analysen i SAS. Det gores ved at dbne vores datasaet Query for boligdata
og denne gang vaelge Analyze > Regression > Generalized Linear Models... som vist nedenfor.
Dette er en anden analysetype 1 SAS, da vi denne gang ogsa skal have den kategoriske variabel
omr_ny med, og det tillader Linear Regression... ikke:

QUERY_FOR_BOLIGDATA +

) Filter and Sort Sy Query Bulder | Data = Describe - Graph - | Analyze =| Export = Send To -+

i) nr i geografi @ kontantp @ AMNOVA 4 @ vaerelse @ kvalitet @
1 14 Brandty 335 | Regression r |£ Linear Regrassion, .,
2 2 BrandbyStrand 1478 -
1= rulkivariake ro| |4 i i
3 3 Espergeerde 00 |4 Manlinear Regression...
4 4 Espergzerde 2250 Survival Analysis » | |if Logistic Regression ...
5 o Espergeerde 1885 Capability » |ﬂ Generalized Linear Models. .. |
6 E Eszpergzerde 1895 g = =
—m - = . _——— ranbeal Charke [ -

Herefter inkluderes de samme fem variable i analysen som i forrige underafsnit 3.3.3 under
hhv. Dependent variable (kontantp) og Quantitative variables (boligst, grundst, vaerelse og
kvalitet) samt denne gang ogsa Classification variable (omr_ny):

Data

Model

Model Dptions
Post Hoc Tests
Fliots
Predictions
Titles
Froperties

Data

[rata source:

Tazk filter: MNone

Yarisbles to azzign:

MHame
@ nr
.gf_‘_} geografi
{2 kontantp
@@ baligst
{2 grundst
{2 vaerelze
{2 kvalitet
@ kv alitetgr
£y omi_ry
.{_;. kantantp_ar
@ durary_hajkwalitet
{2 kvmpris
@ Lh_kontantp

LocalBOLIGLIE.QUERY_FOR_BOLIGDATA

Task roles:

& Quantitative variables

@ buoligst

4 Classification variables
,5:':3 omI_rny

4 Group analysis by

i Frequency count [Limit 1]

Relative weight [Limit: 1]

I Relative offset [Limit; 1)
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Vi skal ogsa specificere modellen, og det gores under Model-valgmuligheden, hvor alle
variablene forst markeres, hvorefter der trykkes Main. Derefter markeres grundst, og der
trykkes pa Polynomial. Slutteligt markeres boligst og vaerelse samtidig (hold Ctrl-knappen pa
tastaturet nede, mens de valges), og der trykkes Cross som vist pa billedet nedenfor:

Data Model
b odel
todel Options
Prast Hoo Tests Clazz and quantitative variables: Effects:
Elrﬂetu;lsictiu:uns gColce! il
: E}} grundst arundst
Titles B P— [ Cross ] vaerelse
Properties e kvalitet
£ kvalitet am_ny
4 amr_ny arundst"grundst
. boligst™aerelze
| Factorial |
[ Paolynomial ]
Degrees: 2 -

Vi behover ikke at &@ndre mere — standardindstillingerne er OK. Tryk derfor pa Run, hvorefter
nedenstaende output fremkommer:

Analysis Of Maximum Likelihood Parameter Estimates

Parameter DF Estimate Standard Error) Wald 95% Confidence Limits | Wald Chi-Square Pr > ChiSq
Intercept 1 -544.573 26915977 -1352.39 -336.354 10.61 0.0011
holigst 1 37153 1.8404 0.1081 73224 4.08 0.0435
grundst 1 09558 0.1921 06053 1.3623 26.34 =.0001
vaerelse 1 54 B5E4 53.2081 -53. 4056 178.7183 075 03379
kvalitet 1 4530193 21.3155 411. 2416 494 7970 451,65 =.0001
omr_ny Mord 1 -1.BRH0 488470 -O7 5533 93,8402 0.00 0.9595
omr_ny Syd 0 0.0000 0.0000 0.0000 0.0000 . .
grundst‘grundst 1 -0.0001 0.0001 -0.0002 0.0000 1.66 01977
boligst'vaerelse 1 02066 03735 0.5254 09357 0. 0.5801
Scale 1 1802120 161919 1609825 2247485

Som det fremgér af p-verdierne, er alle de tre tilfejede variable insignifikante. Derfor skal
de fjernes fra modellen én ad gangen, indtil alle variable er signifikante. Variablen vaerelse
bliver signifikant igen, nar interaktionsvariablen bliver fjernet fra modellen — prov selv at
tjekke. Sa vi ender faktisk pd den samme model som i forrige underafsnit 3.3.3. Det vil i
forhold til omrédevariablen sige, at der ikke er signifikant prisforskel mellem huse nord og
syd for Kebenhavn, nar alle de ovrige aspekter af prisdannelsen pa boligmarkedet tages med
1 betragtningen. At de andre nye variable ogsa er insignifikante betyder, at ogsa den marginale
effekt af en ekstra kvadratmeter grundstorrelse er konstant, og at prisen pa et ekstra veerelse
ikke afhaenger af boligsterrelsen.

I outputtet kommer der ogsa diverse plots, som alle indikerer, at forudsa@tningerne er opfyldte
(da der ikke umiddelbart er monstre i dataene i forhold til residualerne).

Nu ved du, hvordan regressionsanalyser laves i SAS.
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3.3.5. Logistisk regression

Logistisk regression er en teknik til at forudsige en enten/eller-variabel. 1 vores eksempel vil
vi prove at lave en model, der skal forudsige, om en bolig er i hegjkvalitetsgruppen eller e;j.
Hyvis den er, sa er variablen dummy_hajkvalitet = 1. Hvis ikke, sa er denne variabel = 0. Vi vil
bruge kvadratmeterprisen kvm-pris sammen med variablene grundst, vaerelse og omr_ny som
forklarende variable i vores analyse.

Logistisk regression valges i SAS ved at abne vores dataset Query for boligdata og derefter
vaelge Analyze > Regression > Logistic Regression... som vist nedenfor:

QUERY_FOR_BOLIGDATA ~

ﬁ,Filter and Sort %Query Builder = Data = Describe = Graph - |#nalvze «| Export ~ Send To -
@ nr ’3‘1‘; geografi @ kontantp @ ANOW S 4 @ vaerelse @ kvalitet [z
1 1§ Erendby 935 | Regression 4 |£ Linear Regression.. .
2 2 BrondbyStrand 1478 Multivariate v |l i .
—3 3 Espergeerde 100 @ Monlinear Reqgressian, .,
4 4 Espergaerde 2250 Survival Analysis 4 |,4_ Logistic Regression ...
5 5 Espergaerde 1885 Capaility y | 1 Generalized Linear Models., ..
B B Espergeerde 18595 - T =
7 7 Espergeerde 2555 Contolicharts b 3 4

Velg nedenstdende variable til de pa billedet angivne Task roles:

[i Logistic Regression for Local:BOLIGLIB.QUERY FOR_BOLIGDATA

Data Data
Madel
Responze
Effects [ata zowrce:  Local:BOLIGLIE.QUERY_FOR_BOLIGDATA
Selection Task filter: MNane
Options
Plats
P_redictions Wariables to assigr: Task rales:
;:E:;;ties I ame 45 Dependent \raliable [Limit: 1)
i@ @ ummy_haikvalitet
{;:5 geogiafi i Quantltatle vanables
@ kontaritp
@ boligst
@ grundst 4 Classification variables
@ vaerelse o P
[ R

Trek alle variablene over som Main effects:

aatda | Model > Effects
ode

Responze

Class and quantitative variables: Effects:

EE|:;::n E@' kyempris kvmpris
Flats i I@ arundst ElerljISt
Predictions £ vaerelse ;;?lije
Titles & omi_ny B
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Under Options velges Hosmer and Lemeshow goodness-of-fit test og Generalized R-squared.

Data Model > Options
todel
Responze
Effects Details on estimates
Selection [JiCanelston matn= of estimates
Options [] Covariance matrix of estimates
Plots
Predictions )
Titles kodel fit azzessment
Properties [ Influehce statistics

Hozmer and Lemeshow goodhess-of-fit test
[[] Deviance and Pearzon goodness-of-it statistics
Generalized R-zquared

Tryk nu Run, hvorefter outputtet fremkommer. Det bestar af et par tabeller og en lang stribe
grafer. De forste tabeller nedenfor viser, at: 1) AIC falder, nar de forklarende variable inkluderes
1 modellen, hvilket betyder, at de forklarende variable faktisk kan forklare, hvorvidt en given
bolig er i hojkvalitetsgruppen eller ej. 2) R? ligger et sted mellem 48-69%, hvilket umiddelbart
er udmerket. 3) Alle tre tests for modellens overordnede signifikans indikerer, at modellen
samlet set er signifikant.

Model Fit Statistics

Intercept

Intercept and

Criterion Only Covariates
AIC 85.079 47 102
SC 87.313 53.273

2LloglL 83.079 3702
R-Square 0.4864 Max-rescaled R-Square | 0.6948
Testing Global Null Hypothesis: BETA=0

Test Chi-Square DF | Pr = ChiSq
Likelihood Ratio 459765 4 =.0001
Score 3.2798 4 =.0001
Wald 13.7535 4 0.0081

Nar viser pa de enkelte forklarende variable i tabellen nedenfor, kan vi se, at kvadratmeterprisen
er signifikant, og at antal vaerelser er naesten signifikant med en p-vardi pa 0,0681. Men de to
ovrige variable grundst og omr_ny er ikke signifikante:’

Analysis of Maximum Likelihood Estimates

Standard Wald
Parameter DF | Estimate Error| Chi-Square | Pr = ChiSq
Intercept 1 17.8670 49675 12.9369 0.0003
kvmpris 1 -0.94k2 0.2640 12.8461 0.0003
grundst 1 0.000416 0.00103 0.1612 0.658580
vaerelse 1 -0.9334 0.5117 3.3276 0.0651
omr_ny Nord 1 00107 0.4978 0.0005 09323

5. Parameterestimaterne i logistisk regression kan ikke fortolkes ligesd enkelt som ved
almindelig regression, sa det vil vi overlade til din teoretiske statistikbog at introducere.
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Hosmer and Lemeshow, som er testet nedenfor, er ikke signifikant, hvilket betyder, at det ikke
kan afvises, at dataene er brugbare i en logistisk regression. Sa det er jo godt for vores analyses
brugbarhed:

Hosmer and Lemeshow Goodness-of-Fit
Test
Chi-Square DF Pr = ChiSq
13.1136 a £.1080

Alle plots i outputtet (bortset fra sidste plot) bruges til at tjekke forudsaetninger. Der ma ikke
vere igjnefaldende monstre i dataene, hvilket vurderes OK i vores tilfzlde.

Det sidste plot viser effekten af vores mest signifikante forklarende variabel kvm-pris pa
sandsynligheden for, at boligen er i hejkvalitetsgruppen. Plottet viser, at nar kvadratmeterprisen
er over ca. 16.000 kr./m?, sa geetter modellen pa, at boligen er i hejkvalitetsgruppen (dvs.
sandsynligheden for, at variablen dummy_hojkvalitet=0 falder).

Plottet viser ogsa, at kvadratmeterprisen har samme effekt nord og syd for Kebenhavn — fordi
den bla og rede linje praktisk talt ligger lige oven i hinanden.

Predicted Probabilities for dummy_hejkvalitet=0
At grundst=946.8 vaerelse=3.797

1.00

0.75
ol
E 050
[=]
o

0.25

0.00

10 20 30 40
lkvmpris
omr_ny Mord Syd

Det var logistisk regression pa den lette made i SAS.
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3.4. Fordelingstests

Noget af det forste, man skal igennem pd mange indledende statistikkurser, er beregning
af binomiale sandsynligheder, hypergeometriske sandsynligheder, normalfordelings-
sandsynligheder etc. I praksis er det ikke noget, man gor sa meget, og derfor er disse funktioner
pakket lidt af vejen i SAS, men de er stadig tilgengelige.

Nedenfor kommer et eksempel pé tre forskellige fordelingstests i relation til vores boligdatasat
samt eksempler péd, hvordan de beregnes i SAS.

3.4.1. Binomialfordelingstest

Et eksempel pa en binomial sandsynlighed i dette boligdatasettet kunne vere folgende:
Antag, at du er pa jagt efter et hus i Kebenhavnsomréadet. For du lige abner postkassen og
tager boligavisen med ind til morgenkaffen, vil du lige beregne sandsynligheden for, at der
denne givne sendag i &r 2000 maks. er 10 boliger i avisen, som du kunne vare interesseret i,
ud af avisens 100 boligannoncer (du kan normalt né at kere ud at se 10 boliger pa en sendag).
Du ved fra tidligere erfaringer, at du ved forste gjekast kan lide ca. ét ud af fem huse, du ser
1 denne avis, altsa 20% (eller 0,2 udtrykt som en sandsynlighed mellem 0 og 1), og sadan har
det veeret, lige siden du begyndte at holde gje med boligannoncerne 1 denne avis. Antag ogsa,
at der er virkelig godt gang i boligmarkedet i ar 2000, og at det derfor er nye boliger, der er i
avisen hver sgndag.

Opsummering af opgaven

Forst opstilles udtrykket for den binomiale sandsynlighed med sandsynligheden for, at du kan
lide en given bolig p = 0,2 og stikprovesterrelsen n = 100 (du tjekker de 100 tilfeeldige boliger,
der netop er kommet til salg pd denne givne sendag). Da du maks. kan né at tjekke 10, er
din testveerdi x =10. Dette udtrykkes alt sammen i SAS i formlen BIN(p, n, x) og med de
konkrete verdier som BIN(0,2, 100, 10).

Losning i SAS

ISAS kan du beregne hvad som helst via en avanceret formel-editor. Den finder dui dropdown-
menuen Tuasks > Data > Query Builder..., hvor du sa klikker pad Computed Columns i everste
venstre hjorne. Klik herefter pa New og velg Advanced Expression, ligesom det er gjort pa
billedet nedenfor. Klik herefter Next.

I y
i x|
Query name: | Query Buider2 Output name:  [wORK. QUERY_FOR_BOLIGDATA_0

@ Computed Columns @ Prompt Manager _?E:-LPreview _r_'.cfg Tools = | [ Options
B dd T8 x|
= B3t
ELa &
Colurmn Detailz Mew...

New Computed Column

1 of4  Selectatype Ssas

 Summarized column

C' Fecoded column

() Advanced expression

W W W e R (0 e )
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SAS kalder det ikke BIN men PROBBNML (p, n, m), som du kan se af billedet nedenfor.
Bemerk, at du sandsynligvis skal bruge punktum i stedet for komma, nar du fx skriver
sandsynligheden 0,2 (det afth@nger af, hvordan din PC er indstillet, da SAS spejler dine lokale
sprogindstillinger).

Enter an expression:
PROBEMML( 0.2, 100,10

Home End  Undo Edit = Favorites »  Validate

+ -l oW ™, ‘abcn
) POF Function ~ ~
) PERM Function PROBBNML Function

£ POISSON Functi . B
10 PHDBEETA“:;:SW Returns the probability from a binomial

FBYFROBENML Function distribution
f) PROBBMRM Function
£ PROBCHI Furction Syntax
. F0 PROBF Functian - PROBBMML(p,n.m) (z) Binomial sandsynlighed
w

| 0.005696321

Klik herefter pa Next, hvor du kan give beregningen et navn (kald den fx ”Bin”), klik
derefter Finish > Close og Run. Dette resulterer i den beregnede binomiale sandsynlighed
pa 0,005696381, eller ca. 0,6%. Det er med andre ord uhyre usandsynligt, at der kun er 10
eller ferre huse, som du synes er interessante, i Sendagsavisen, som du nu vil ind og lase til
morgenkaffen. Du ma altsa prioritere, hvilke huse du vil ud at se pa.

3.4.2. Hypergeometrisk fordelingstest

Lad os antage, at der denne sendag er hele 69 huse, som har din interesse, og at du vil udvelge
10 tilfeldige herfra. Du vil selvfolgeligt ikke kore ud at se det samme hus flere gange, og derfor
er dette et eksempel pa en sdkaldt hypergeometrisk sandsynlighedsfordeling i stedet for en
binomialfordeling. Du ved fra tidligere erfaringer, at du kan lide ca. ét ud af fem huse, som du
korer ud og ser pa, altsd igen en sandsynlighed pa 0,2 ligesom for. Dvs. at 20% af de 69 huse
vil falde i din smag, altsd 0,2*69=13,8 = 14 af husene. Hvad er sandsynligheden for, at duidag
finder hgjst to huse, du kan lide, ud af de 10 huse, du tager ud for at tjekke?

Lesning i SAS

Svaret findes nasten pa samme made som ved binomialfordelingseksemplet tidligere. Den
anvendte funktion hedder nu bare PROBHYPR(N, K, n, x), hvor N er de 69 udvalgte
boligannoncer, K er det forventede antal af dem, som du vil vere virkeligt interesseret i, n
er det antal boliger, du kan na at tjekke i dag, og x er det antal, vi tester som @vre grense.
Dvs. den formel, du ender med at have indtastet, hedder PROBHYPR(69, 14, 10, 2). Nar du
beregner den, giver det 0,67366, dvs. der er ca. 66% sandsynlighed for, at du finder maks. 2
huse, du virkelig godt kan lide i dag, ud af de 10 huse, du planlegger at kore ud at se pa. Prov
at se, om du kan komme frem til samme resultat i SAS.

Enter an expression:
FROBHYPR[ 69 .14 .10, 2)

Home End Edit = Favorites »  Validate

Y S | T S SRR -
£} PROBBMRM Functic # 2
) PROBCHI Functian PROBHYPR Function

f6) PROBF Functi .
0 PHDBGA;”ELEZHW Returns the probability from a

FOEEREEEEEE | hypergeometric distribution
) PROBIT Function
Fid FROBMC Function Syntax @ Hypergeometrizk sandsynighed
P fih PRMBKESR Ellnr\;n PROBHYPR(NIKInIXqu}) v | DE?EEEE?EEB
L]

Osas



STATISTIK MED SAS®
Side 71

3.4.3. Normalfordelingstest

Lad os antage, at din bank har givet dig lov til at kebe hus for maks. 1,7 mio. kr. Du ved
fra tidligere, at gennemsnitsprisen pa de huse, du er interesseret i, er ca. 2,3 mio. kr., og
standardafvigelsen er 0,8 mio. kr. Hvis du i dag finder et hus, du virkelig godt kan lide, pa din
vej rundt for at se pa dine udvalgte huse fra boligavisen, hvad er sa sandsynligheden for, at du
har rad til det givne hus?

Losning i SAS

P4 samme made som i de to foregdende eksempler anvendes den avancerede formel-editor,
hvor normalfordelingstesten indtastes som PROBNORM/(x). Da PROBNORM-formlen
anvender standardnormalfordelingen (den med gennemsnit pa 0 og standardafvigelse pa 1),
skal vores prisgrense pa 1,7 mio. kr. standardiseres”, siger man. Det gor man ved at traekke
gennemsnittet fra og dividere med standardafvigelsen, altsa ved at sige 1,7 minus 2,3 = -0,6,
som sa divideres med 0,8, hvilket giver -0,75. Dvs. at det, du skal indtaste i formel-editoren,
er PROBNORM/(-0,75) (eller PROBNORM ((1,7 —2,3)/0,8)), hvilket giver 0,2267. Der er
altsé knap 23% sandsynlighed for, at du har rad til det givne hus.

@ Mormalfordelings sandsynigl‘ﬂ:l|
0 2266273524

Hermed slutter vores rundtur i SAS-peg og klik. Har du mod pd mere, sd prov at lese Kapitel 4
ogsd, som dbner en helt ny verden af dataanalysemuligheder med SAS-programmering — der vil
vi som eksempler se nwrmere pd, hvordan koden til nogle af de analyser vi har lavet via peg og
klik, ogsa kunne laves med et par linjers SAS-kode — og derefter evt. automatiseres via anden
kode ... Mulighederne er ubegrensede!
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INTRODUKTION TIL

SAS-PROGRAMMERING

SAS er baseret pa programmeringskode, som kerer inde bagved. Det er virkelig smart, for det
betyder, at hvis dit dataset bliver opdateret (fx ved en storre eller ny stikpreve), kan du ogsa
opdatere dine analyser pa ingen tid bare ved at vaelge Run > Run Process Flow og sa aflese
alle de opdaterede output. S& Process Flow-diagrammet giver bade det forkromede overblik
og betyder ogsé, at du kan tenke i én SAS EG-projektfil til ét studie- eller arbejdsprojekt — og
ikke mange forskellige dataset.

Engang imellem har man dog brug for endnu mere automatisering af sin datahandtering, og
hvis du skulle fa den slags behov, kan det godt betale sig, at du bruger lidt tid pa at lere lidt
SAS-kodning. Det er lidt som at l@re et nyt sprog, hvor man dog kan komme langt med at
kunne bare en lille smule, og det er ogsad meget lettere at lere i dag end tidligere, fordi SAS
automatisk foreslar ord og valgmuligheder. Alt dette ser vi neermere pa nedenfor.

4.1. Automatisk kode, integreret hjaelp og code completion

For at snuse lidt til SAS-programmering er koden til et par af de forskellige tests, vi har
lavet 1 denne e-bog, tilfgjet her som eksempler. Husk, at du ogsa altid kan finde koden til de
forskellige tasks (=handlinger) i SAS pa Code-fanen, som automatisk genereres, hver gang
du kerer en task. Den automatisk genererede SAS-kode er dog i de fleste tilfeelde lidt mere
kompleks, end den beheover at vaere — fordi den jo skal vaere meget generel og virke i alle
tenkelige kombinationer. Nedenfor ser du noget af koden fra Code-fanen til vores forste test i
denne e-bog (test af ét gennemsnit fra underafsnit 3.1.1 pa side 38). Man skal lige scrolle lidt
ned for at kunne se SAS-koden nedenfor:

One mean b Tesk - X

';EE Input D ata _1 Cade L”l Log | ‘& Results
|_Tl Modify Task | Export » Send To - Properties

- PROC TTEST
DATA = WORE.TMEPOTempTableInput
PLOTS (CONLY )=INTERVAL
ALPHA=0, 05
HO =150
oI = EQUAL;

el

VAR holigst;
BUN;

Det, du ser ovenfor, er den SAS-kode, der genererer et One mean t Test. Der ligger andet kode
bade over og under — kode, som ikke beheves, hvis du kerer testen selv via SAS-kode. Det er
det, vi nu vil preve at gore.
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OK —nu har vi set koden. Lad os prove at skrive koden selv i et nyt SAS-program inden i vores
SAS-projekt. Abn forst et nyt *program’ via File > New > Program:

[& SAS Enterprise Guide - 2012-05-24 Boligdata projekt.egp

File | Edit  wWiew Tasks Program  Toals  Help | S~ 5 &G | S [

_|§] Mew 4 |g Project
E Open b

Close Project

|_’3 Data
|§l Program |e

e

I det tomme vindue gar du nu i gang med at skrive koden til t-testen. Koden pa foregaende
side starter med PROC, som er en forkortelse for en procedure, som koden skal udfere. Det er
for evrigt fuldstendig lige meget, om du anvender store eller sma bogstaver i koden:

- PROC] - PROC TT
| PROC ~ ! TTEST ~
| PROCEDURE 1 UCH
| QuiT ! UNIMARIATE
| RDISPLEY I, WARCLUS
| RESETLINE !, WARCOMP
| RGET ! WARIDGRAM
| RSUBMIT L WARMAY
| RUN 1w
| RUM CANCEL v 1 %12 v

Som du kan se ovenfor og pa din egen skaerm, gar SAS straks i gang med at gette, hvad du
prover at kode. Det hedder Code Completion og er en stor hjelp til at leere at kode og undgé
fejlisin kode. Nar du fortsetter med at skrive TTEST, ser du igen, hvor hjelpsom SAS er med
kodningen. Du kan bare trykke pa Enter eller pad mellemrumstasten pa dit tastatur, nar SAS
har geettet, hvad du gerne vil skrive.

Nu skal vi til at skrive DATA = <...>

I stedet for at skrive DATA=WORK.<...> kan vi jo passende anvende vores eget data /ibrary
BOLIGLIB, for det er jo her, vores dataset Query_For_Boligdata ligger (SAS anvender et
midlertidigt dataset — det er ikke relevant her). Nar vi har skrevet vores library navn, forteller
SAS os, hvilke datasat vi kan velge imellem i library’et:

- PROC TTEST
DATA=ECOLIGLIE.

["] BOLIGDATA,
[] QUERY_FOR_BOLIGDATA,
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Hvis vi nu ikke havde forrige sides kode som skabelon, kunne man godt komme i tvivl om,
hvad man skulle skrive som det naste. Her har SAS heldigvis integreret hjelp, ligesom du
kender det fra Microsoft Office 2007 og frem — dvs. nar du holder musen oven pa de ord,
som SAS genkender (alle dem, der er bla i koden), s& forteller SAS, hvordan koden skal
struktureres. I billedet nedenfor er musen holdt oven pa TTEST:

- PROC TTEST

O kepword: TTEST
Context: [PROCEDURE DEFINITION] PROC TTEST

Syntaw: PROC TTEST <optionss ;
CL&SS wvarable ;
PAIRED waniables ;
BY wariables ;
WAR vanables </ optiong: ;
FREQ wanable ;
WEIGHT vanable ;

The TTEST procedure performs b testz and computes confidence limitz for one zample, paired
obzervations, two independent zamples, and the AB/BA crozzover design.

Search: The Product Documentation, Samples & 545 Notes, Papers

De forste fire linjer, vi mangler at skrive, er under <options> efter PROC TTEST i syntaksen®
ovenfor. Den femte linje vi mangler, er den med VAR variables. Resten har vi ikke brug for.

Vi skriver altsé videre pa koden, indtil den ser ud som nedenfor:

- PROC TTEST
DATA=BOLIGLIE.QUERY FOR_BOLIGDATA
ELOTS (ONLY) =INTERVAL
ALEPHA=0. 05
HO =150
oI = EQUAL;

VAR boligst;
EUN;

6. Syntaks betyder kodestruktur.
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Prov at trykke pd Run- knappen nu. Herefter fremkommer nasten det samme output, som du
fik, da vi kerte vores oprindelige One mean t-test. Den eneste forskel er, at vores plot ikke er
kommet med ud denne gang:

Program -
%] Pragram | 2] Log| % Results
L9 Refresh | Export = Send To ~ Create ~ Properties

The TTEST Procedure

Variable: boligst

N|Mean Std Dev Std Err Minimum Maximum
B9 1645 50.2437 B6.0486  80.0000 357.0

Mean 95% CL Mean | Std Dev 95% CL Std Dev
1646 16825 1766 &0.2437 430351 BD.3758

DF t Value Pr = |t
Ba 2.40 0.0190

Page Break

Tilbage i Process Flow-diagrammet kan du ogsé se, at der nu er kommet et Program med pa
listen af Tasks, vi har udfort:

-

Program SA5 Feport
- Program

SAS viser en lille advarselstrekant i hejre hjorne af programmet ovenfor, og det har med
vores manglende plots at gere. For hvorfor kom de egentlig ikke med ud, nar vi nu fik dem
sidst? Det har med koden at gore — vi glemte lige at fa en lille ting i forhold til grafer med,
da vi kopierede koden for, nemlig et siakaldt ODS-statement, som er SAS’ kodesprog til at
“kalde” grafer.” Vi kan ogsa lige prove at kigge i loggen fra vores program. En log er altid lidt
omfattende, si maden at gribe den an pé er at skimme den igennem for at se, hvor der star
nogle kommentarer med andre farver end gren. Det er gjort nedenfor:

Program -

‘%JJ, Program =] Leg & Resuls

Export » Send To - i 4 r} Project Log Properties
Z1
ZZ VAR boligst;
23 RUN;

WARNING: You must enakble OD® graphics with the ODE GRAPHICE ON statement before reques

plots.
NOTE: PROCEDURE TTEST used (Total process time):
real time 0.01 seconds
cpu time 0.01 seconds

Som du kan se i loggen ovenfor, sa giver SAS os en Warning, hvor der ret tydeligt star, hvad vi
skal gore. Hvis du kigger i den originale kode fra vores One mean t-test genereret af SAS, kan
du finde et sted, hvor der stair ODS GRAPHICS ON forst i koden og igen ODS GRAPHICS
OFF i slutningen af koden. Lad os prove at tilfgje det til vores kode fra for.

7. At ’kalde” i kodesprog betyder at bede computeren om at gere et eller andet, fx lave grafer.
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Resultatet skal se ud som nedenfor, hvor der altsa skal sta ODS GRAPHICS ON for vores
ovrige kode og ODS GRAPHICS OFF til sidst i koden. Det er ligegyldigt, om du bruger store
eller sma bogstaver:

oDE GRAPHICE ON

EROC TTEST
DATA=EOLIGLIE.QUERY FOR BOLIGDATA
PLOTS (ONLY)=INTERVAL
ALEPHA=0. 05
HO =150
oI = EQUAL;

VAR boligst;
RUN;

oDE SRAPHICE OFF

Prov at trykke p&d Run-knappen nu — s vil du blive introduceret til den nok hyppigste kodefe;jl
1 SAS: at man har glemt semikolon efter sin kode:

%] Program | =] Log
Export ~ Send To = F b |[Z&Project Log Properties
15 oD08 graphics ON
16
17 FROZ TTEST
ZZ
17 FROC TTEST
zZoz
ERROR 22-322: @yntax error, expecting one of the following: ;, /.
ERROR 202-32Z2: The option or parameter is not recognized and will be ignored.

Vi har glemt et semikolon efter vores ODS-statements. Det betyder, at SAS laeser videre og
forventer, at der kommer mere i forhold til ODS-kommandoen i stedet for at begynde pa at lese
en ny kommando ved PROC pé nzaste linje. Denne fejl er en, som alle hopper i et par gange,
nadr man begynder at kode SAS — ja, den er faktisk sa almindelig, at der er dem, der pastar, at
SAS er en forkortelse for St Altid Semikolon! :-) Hvis du sammenligner forrige skaermbillede
med dem tidligere, kan du ogsa se, at teksten med PROC TTEST i forrige billede ikke leengere
er morkebld — dvs. ikke genkendt af SAS som en kommando. Loggen ovenfor indikerer, hvad
problemet er (SAS is expecting one of the following: ; ...), men det star ikke direkte.
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Lad os skynde os at fikse det med to semikolonner — et efter hvert ODS-statement, som det er
gjort nedenfor:

ODE GRAPHICE ON;

- PROC TTEST
DATA=BOLIGLIE. QUERY FOFR EBOLIGDATA
ELOTE(ONLY ) =INTERVAL
ATLEHA=0, 05
HO =150
CI = EQUAL;

VAR bholigst;
RUH;

oDE GRAPHICS OFF;

Prov at trykke pad Run-knappen nu, hvorefter vi far vores enskede output frem — denne gang
med grafen:

Program -

21 Program® | [Z] Log & Resuls
{5 Refresh | Export » Send To = Create - Properties

The TTEST Procedure

Variable: boligst

N Mean Std Dev Std Err Minimum |[Maximum
B3 1645 &0.2437 EB.0486  80.0000 3570

Mean 95% CL Mean  Std Dew| 95% CL Std Dewv
1645 16246 1766 602437 430351 B0.3758

DF tValue Pr= |t

63 240 0.0120

Mean of boligst
With 95% Confidence Interval

<> Mean

Nu er ovenstaende graf jo ikke verdens mest interessante graf, men nu har du lert, hvordan
du far grafer med i dit SAS-output. Grunden til, at grafer ikke kommer med af sig selv, er, at
koden kerer hurtigere uden. Og hvis det nu var et kempe dataset med mange kommandoer
og beregningstunge grafer, sa er det jo praktisk nok, at man ikke skal vente pa grafer, som man
maske er ligeglad med, ikke?
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Prov nu at gemme dit projekt (tryk evt. bare pa Crrl+s pa dit tastatur for at gemme) og luk
derefter SAS helt ned. Prov sa at abne SAS igen og abn dit program igen via Process Flow-
diagrammet. Tryk derefter pad Run-knappen. Herefter kommer loggen frem med en fejlmelding:

’El Proararm :1 Log
Export ~ Send To - F ok f}ProjectLog Properties
15 ODS graphics ON;
1&
17 FROZ TTEAT
18 DATA = BOLIGLIE. QUERY FOR BOLIGDATA
15 PLOTE ({ONLY)=INTERVAL
ERROR: Libname BOLIGLIE is not assigned.
Z0 ALPHA=0.05
21 HO =150
22 I = EQUAL;
23
24 VAR holigst;
25 RUN;
NOTE: The 845 Svystem stopped processing this step because of errors.

Problemet er, at SAS ikke kender dit libname. Pa din PC ville det méske vare smart, hvis SAS
huskede dine /ibnames, men i for store organisationer med utallige SAS-brugere pa det samme
SAS-system ville det vere lidt problematisk, hvis alle brugere skulle anvende forskellige
libnames altid, og hvis et libname, der blev genbrugt, ellers kunne pege forskellige steder hen.

Lesningen er dog enkel: Vi skal bare tilfoje koden fra vores libname statement overst i vores
program. Vores SAS /ibrary var faktisk det allerforste, vi udferte i SAS i denne e-bog, tilbage i
underafsnit 2.1.1 pa side 9. Vi finder koden ved at kore vores Assign Library task igen, som er
den overste task i vores Process Flow diagram:

Process Flow =

[ Run - Export » Schedule « | Zoom - f} Project Lt

o 3
=S oeen
[—
A&Sig| = Run
Froje; - - - -
Libra I-TJ, Modify Assign Project Library (BOLIGLIE)

e

Herefter fremkommer fanerne Code og Log, hvor vi velger kodefanen. Her star den kode, vi
skal tilfoje, overst 1 vores program for altid at have vores libname defineret. Din sti til dataene
”C:\...” ser helt sikkert anderledes ud — den peger jo pa der, hvor du har gemt dine data, og det
ville jo veere sert, hvis du havde lagt dine data helt det samme sted, som jeg har. Derfor skal
du ikke @ndre i koden i dit /ibname statement, men Kopiere det, som det er pa din PC. Jeg viser
bare, hvordan det ser ud pa min skerm:

Assign Project Library (BOLIGLIB) -

=) Code =] Log
El Modify Task | Export ~ Send To - Properties

LIENAME BOLIGZLIE BABE "C:“.Documents and SettingshAdwministratorDesktoph 342 Projects" ;
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Hvis du tager din /ibname-kode og kopierer ind everst i dit program, ser det ud som nedenfor:

&) Program =] Log
H Save ~ [ Run - Zelected Server: Local (Connected) - Analyze Program = | Export = Send To - Properties

LIENAME EBOLIZLIE BASE "C:%Documents and SettingshAdministratoriDesktophB8A3 Projects” ;
OD8 graphics ON;

- PROC TTEST
DATA = BOLIGLIE.QUERY FOR EOLIGDATA
PLOTE (ONLY) =INTERVAL
ALPHA=0. 05
HO =150
CI = EQUAL;

VAR boligst;
RUH;

Prov at kere din kode nu (tryk Run). Nu virker det bare, og du far dit output med det samme.
Og det virker ogsa, hvis du lukker og dbner SAS igen.

Nu kan vi jo preve en lille variation. Prov at &ndre H -hypotesen til at teste, om boligsterrelsen
er signifikant forskellig fra 160m2. Det gores bare ved at @ndre de 150 i koden til 160 i stedet.
Vi kan ved samme lejlighed prove at @ndre signifikansniveauet til 0.10 i stedet. Med disse
@ndringer ser koden ud som nedenfor:

- PROC TTEST
DATA=BOLIGLIE.QUERY FOFR_EBOLIGDATA
PLOTE (CHLY ) =INTERVAL
ALFPHA=0. 10
HO =160
2T = EQUAL;

VAR koligst;
RUH ;

Prov nu at kere testen (tryk Run) og afles resultatet — med en p-verdi pa 0,4559 kan vi i dette
tilfelde ikke afvise HO-hypotesen (outputtet er ikke vist her).

Tillykke — du har nu lavet et komplet funktionelt SAS-program skrevet i SAS-kode!

Selvfolgeligt har vi her kun vist dig toppen af isbjerget i forhold til SAS-kodning. Har du féet
mod pa mere, sa har SAS lavet en lille bog, der meget passende hedder ” The Little SAS Book:
A Primer”. Den er god til at komme i gang med kodning og er let l&esning og kan bruges som
opslagsveerk og til ovning i grundleggende SAS-kodning. Du kan bl.a. kebe den pa internettet
via www.amazon.co.uk. Du kan ogsé altid finde svar ved at google om SAS-kode — der er
mange, der bruger SAS derude.

Osas



STATISTIK MED SAS®
Side 80

4.2. Kodeeksempler til denne e-bog - spar tid og dokumentér!

Alt det, vi har lavet i denne e-bog, kunne vare lavet med et par kodestumper som dem pa de
folgende par sider. Koden her er skrevet noget kortere end den automatisk genererede kode
for at vise, at det ikke behover at vaere sa svert.

Koden er faktisk ogsad en virkelig god dokumentation for alt, hvad vi har gjort ved vores
data — enhver kan gentage vores analyser med denne kode og fa nejagtig de samme resultater.
Pa samme made kan du vedhafte din kode og dit dataset til sterre projekter — s har du
dokumenteret dit arbejde!

Vi starter som altid vores kode med et Libname statement og gar derefter videre til at lave vores
’Query_For_Boligdata’-dataset. Det tog os masser af indtastningstid og mange sider i denne
e-bog at lave den query — i SAS-koden nedenfor fylder vores DATA?® step, som laver det samme
datasat, kun 11 linjer reel kode.

Resten af denne manual er skrevet i SAS-kode — man kan nemlig uden problemer skrive
kommentarer til sig selv og sine samarbejdspartnere i SAS-koden, som du kan se pa den
gronne skrift i koden nedenfor (den mellem /* og */). Prev at abne et nyt, tomt SAS-program
(File > New > Program) og inds@t kodeteksten nedenfor deri. Det eneste, du behover at
@ndre, er stien til dine data i 2. linje nedenfor (vores Libname statement). God forngjelse med
SAS-kodningen — er du néet helt hertil, s kommer du helt sikkert ogsd godt videre.

/* Fgrst laver vi vores SAS Library reference: */
LIBNAME BOLIGLIB "C:\Documents and Settings\Administrator\Desktop\SAS Projects"

/* Herefter laver vi vores 'Query For Boligdata' datasat med SAS kode.
Den automatiske kode fra SAS peg-og-klik bruger SQL-kodning til query'en.
Her bruger vi i stedet almindelig SAS kode. Laeg merke til at variablene
Automatisk bliver defineret ndr vi nevner dem i koden (fx omr ny = (.)): */

DATA BOLIGLIB.QUERY FOR BOLIGDATA;
SET BOLIGLIB.BOLIGDATA;
/* omr ny */
IF omr = 1 THEN omr ny = 'Nord';
ELSE IF omr = 2 THEN omr ny = 'Syd';
/* kontantp gr */
IF kontantp <= 1500 THEN kontantp gr = 'Lav';
ELSE IF kontantp >= 1501 AND kontantp <= 2500 THEN kontantp gr = 'Middel';
ELSE IF kontantp >= 2501 THEN kontantp gr = 'Hgj';
/* dummy hgjkvalitet */
IF kvalitetgr = 3 then dummy hgjkvalitet = 1;
ELSE dummy hgjkvalitet = 0;
/* kvmpris */
kvmpris = kontantp / boligst;
FORMAT kvmpris 8.2;
/* Ln_kontantp */
In kontantp = (LOG (kontantp));
FORMAT Ln_ kontantp 8.2;
RUN;

/* Tend for ODS grafik sd vi far figurer med i1 vores outputs
(grunden til at det ikke er standard, er at man kan spare tid

uden grafikken ved store datasat og mange beregninger) */

ODS GRAPHICS ON;

8. DATA eller PROC er de to ord, som pabegynder 99% af al SAS-kode! DATA steps bruges
fx til at lave nye dataset som i vores Query. Den automatisk genererede kode anvender dog
SQL-kode, men her har vi gjort det samme med almindelig SAS-kode.
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/* Test pa ét gennemsnit */
PROC TTEST DATA=boliglib.query for boligdata
PLOTS (ONLY)= INTERVAL
ALPHA= 0.05
HO = 150
CI = EQUAL;
VAR boligst;
TITLE1l "Test pa& ét gennemsnit";
RUN;

/* Test pa& to uafhengige gennemsnit */
PROC TTEST DATA=boliglib.query for boligdata
PLOTS (ONLY) = INTERVAL
ALPHA= 0.05
HO = 0
CI = EQUAL;
CLASS omr ny;
VAR kontantp;
TITLEl "Test af forskellen mellem to uafhzngige gennemsnit";
RUN;

/* Test pa& tre eller flere gennemsnit (One-Way ANOVA) */
PROC ANOVA DATA=boliglib.query for boligdata;

CLASS kvalitetgr;

MODEL kontantp = kvalitetgr;

MEANS kvalitetgr / HOVTEST=LEVENE BON ALPHA=0.05;

TITLE1l "One-Way ANOVA test pa prisforskellen mellem de tre kvalitetsgrupper";
RUN;

/* To-faktor ANOVA */
PROC GLM DATA=boliglib.query for boligdata PLOTS=INTPLOT;
CLASS kvalitetgr omr ny;
MODEL boligst = kvalitetgr omr ny kvalitetgr*omr ny;
TITLE1l "To-faktor ANOVA test pa& forskellen mellem boligsterrelser for hhv.
kvalitetsgrupper og omrade";
RUN;

/* Test af én andel (om der er lige mange huse til salg i nord og syd) */
PROC FREQ DATA=BOLIGLIB.QUERY FOR BOLIGDATA;

TABLES omr_ny / BINOMIAL (p=0.5);

EXACT BINOMIAL;

TITLEl "Test af én andel";
RUN;

/* Test af om to andele er signifikant forskellige
(om andelen af hgjkvalitets huse er ens nord og syd for Kgbenhavn) */
PROC FREQ DATA=BOLIGLIB.QUERY FOR BOLIGDATA;
TABLES dummy hgjkvalitet * omr ny / CHISQ;
TITLEl "Test af forskellen mellem to andele";
RUN;

/* Uafhe&ngighedstest (Chi-square test) for om kvalitets gruppe og
kontantpris gruppe er uafhengige */
PROC FREQ DATA=BOLIGLIB.QUERY FOR BOLIGDATA;
TABLES kvalitetgr * kontantp gr / chisg;
TITLEl "Uafhaengigheds test (Chi-square test)";
RUN;

/* Scatter plot for kontantprisen ift. boligsterrelsen */
PROC GPLOT DATA=boliglib.query for boligdata;

PLOT kontantp * boligst / FRAME ;

TITLEl "Scatter Plot mellem kontantprisen og boligstgrrelsen";
RUN; QUIT;

Gsas




STATISTIK MED SAS®
Side 82

/* Korrelations analyse mellem kontantprisen og boligstgrrelsen */
PROC CORR DATA=BOLIGLIB.QUERY FOR BOLIGDATA;

VAR kontantp boligst;

TITLEl "Korrelations analyse";
RUN;

/* Simple lineaxr regression hvor kontantprisen forklares ud fra boligstgrrelsen */
PROC REG DATA=BOLIGLIB.QUERY FOR BOLIGDATA

PLOTS (ONLY) =ALL;

MODEL kontantp = boligst;

TITLEl "Simple linear regression";
RUN;

/* Multipel korrelationsanalyse mellem kontantprisen og fire andre variabler */
PROC CORR DATA=BOLIGLIB.QUERY FOR BOLIGDATA;

VAR kontantp boligst grundst vaerelse kvalitet;

TITLE1l "Korrelations analyse med flere variable";
RUN;

/* Multipel line®r regression med kontantprisen og de fire andre variabler
(Du kan evt. selv prgve at erstatte 'kontantp' med 'ln kontantp' i koden nedenfor) */
PROC REG DATA=BOLIGLIB.QUERY FOR BOLIGDATA
PLOTS (ONLY) =RESIDUALBYPREDICTED
PLOTS (ONLY) =QQPLOT
PLOTS (ONLY) =RESIDUALPANEL
PLOTS (ONLY) =FITPLOT;
MODEL kontantp = boligst grundst vaerelse kvalitet / VIF SPEC;
TITLE1 "Multipel linear regression";
RUN;

/* Multipel regression med dummy-variabel, kvadreret variabel og interaktionsvariabel */
PROC GENMOD DATA=BOLIGLIB.QUERY FOR BOLIGDATA PLOTS (ONLY)=ALL;
CLASS omr_ny;
MODEL kontantp = boligst grundst vaerelse kvalitet omr ny
grundst*grundst boligst*vaerelse;
TITLEl "Regression med dummy-variabel, kvadreret variabel og interaktionsvariabel";
RUN;

/* Logistisk regression */
PROC LOGISTIC DATA=BOLIGLIB.QUERY FOR BOLIGDATA DESC PLOTS (ONLY)=ALL;

CLASS omr_ny;

MODEL dummy hgjkvalitet (Event = 'l') = kvmpris grundst vaerelse omr ny / RSQUARE;
RUN;

/* Fordelingstests */

DATA BOLIGLIB.FORDELINGSTESTS;
Binomial sandsynlighed = PROBBNML( 0.2 , 100 , 10 );
Hypergeometrisk sandsynlighed = PROBHYPR( 69 , 14 , 10 , 2 );
Normalfordelings sandsynlighed = PROBNORM(( 1.7 - 2.3 ) / 0.8 );
TITLEl 'Fordelingstests';

RUN;

/* Sla grafikken fra igen*/
ODS GRAPHICS OFF;
/* Det var det - pgj pw) fremover med SAS! */
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Efter at have leest denne bog er du nu rustet til at g& i gang med at arbejde i SAS. Vil du gerne
vide mere om mulighederne i SAS, kan du starte med folgende:

SAS Enterprise Guide - peg og klik:
SAS for Dummies
Stephen McDaniel and Chris Hemedinger

SAS programmering:
The Little SAS Book: A Primer
Lora Delwiche and Susan Slaughter

E-learningkurser tilgeengelige via www.sas.com (gratis for studerende, undervisere
og forskere):

SAS Programming I: Essentials

SAS Programming II: Data Manipulation Techniques

Skulle du have yderligere spergsmaél, er du velkommen til at kontakte os pa
academic.dk@sas.com
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